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Chapter 1

Welcome

Welcome to DacEasy Version 14. DacEasy offers a complete line of business software for
the small to medium-size business in need of an affordable, yet powerful, business solution.

For more than two decades, we have listened to our customers’ suggestions to develop a
robust business system with the features needed to successfully grow a business. Version 14
continues this tradition by focusing on features designed to make you more productive.

This chapter gets you started using DacEasy. Review the system requirements prior to
installing the program to ensure that your system can successfully run DacEasy. If your
system meets the minimum requirements, you can proceed with the instructions on
installing DacEasy and starting the program using the Business Center.

This chapter also includes a Conversion Preparation Checklist. If you are upgrading from a
previous version, use this checklist to ensure that you have completed the preliminary steps
required for a successful conversion. After completing the checklist you can follow the
instructions for converting your data to Version 14.

You must set up at least one company profile to access the Business Center. The profile
stores the paths to all of your data files for a single company so that you can seamlessly
access your company data, regardless of the module in which the data is stored. This
chapter includes the steps to perform to add company profiles.

This chapter also explains how to move data files, exit the Business Center, open company
files and set up a security passport.files and set up a security passport.

Installing
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Minimum System Requirements
The following system requirements are the recommended minimums for running DacEasy:

Pentium® III or equivalent microprocessor running at a minimum of 1.5 GHz,
Pentium IV or equivalent microprocessor at 3 GHz recommended

256 MB of free RAM minimum, 512 MB of free RAM recommended

Windows® XP Professional, Windows 2000 Server/Professional,

Note  Windows 2000 Advanced Server and Windows Terminal Services are not
supported. Windows XP fast user switching is not supported.

Mouse or compatible pointing device

Hard disk drive with 80 MB of hard disk space available for a single module, plus
50 MB for each additional module

4x CD-ROM drive

VGA Display (256 or more colors) with at least 800 x 600 resolution, 1024 x 768
recommended (16 bit high color recommended for the Business Center)

Microsoft® Internet Explorer  6 (included on CD)

Note  Additional disk space is required if Microsoft Internet Explorer needs to be
installed.

Optional System Requirements
Windows-compatible printer

28800 or higher-baud modem for Phone Dialer and NPC Direct Deposit

Internet Service Provider (ISP) for Online Tax Updates and WebStore

Microsoft Word XP or 2003  for Word Mail Merge

Microsoft Excel XP or 2003 to publish to Microsoft Excel

Timeslips by Sage, Version 14 for Timeslips Link

Adobe®  Reader® Version 6 certain DacEasy Payroll forms (Acrobat Reader
included on CD)
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Crystal Reports® (Add-on module) if using the Crystal Reports  Version 11 feature
in the DacEasy Business Center

Simple MAPI compliant e-mail program to send e-mails.

Bar code scanner*

Credit card swiper*

Serial or  parallel cash drawer**

40- or  80-column receipt printer**

Pole display; two line 20-character serial display**

* Applicable to DacEasy Order Entry and DacEasy Point of Sale only
** Applicable to DacEasy Point of Sale only
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Installing DacEasy

Important  If you are installing on a network, do not install the program until you read
Appendix A, “Networking.” In addition, if you are upgrading from a previous version, read
the “Upgrading From a Previous Version” section in this chapter before continuing with the
following steps.

To Install DacEasy
1. Insert the CD in the appropriate drive. The Introduction screen

automatically appears.

Note  Be sure to close all programs including the Pervasive Database
engine before installing DacEasy.

If the Introduction screen does not automatically appear, click the Start
button, and then select Run. Open the Msetup.exe file on the CD. The
Introduction screen appears.

2. Click Install DacEasy. The Setup program starts.

3. Follow the instructions on your screen to install DacEasy.

Note  If you are upgrading from a previous version of DacEasy, pay
close attention to the Upgrade Modifications screen when it appears. This
screen allows DacEasy to copy any necessary information to your new
program folder and aids in converting any necessary data once you run
the Version 14 program. Using the options on this screen also helps locate
your existing companies when using the Add Module wizard in the
DacEasy Business Center.

Tip  We recommend that you select the View Readme File check box
during Setup. Read this file to familiarize yourself with the new features
and learn about any last minute changes. After viewing this file, select
Close from the File menu to exit the Readme file and return to Setup.
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Adding and Removing Components
After you have installed DacEasy, you can run Setup again at any time to add or remove
components.

Note  If you run Setup again, you also have the option to reinstall or remove the program.
Select Repair from the Welcome screen to reinstall existing DacEasy files. Select Remove
to remove all installed components from your computer.

To Add or Remove Components
1. Insert the CD in the appropriate drive. The Introduction screen

automatically appears.

If the Setup screen does not automatically appear, click the Start button,
and then select Run. Open the Msetup.exe file on the CD. The
Introduction screen appears.

2. Click Install DacEasy. The Setup program starts.

3. Select the Modify option, and then click Next.

4. Follow the instructions on your screen to add new components or remove
existing components.
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Starting DacEasy
The DacEasy Business Center provides a single entry point for all DacEasy programs. Fast
and easy access to your program is only one of the many benefits gained when you use the
Business Center to access DacEasy. You can use any of the following methods to start the
Business Center:

Note  Starting the Business Center is usually the preferred method of accessing company
data; however, if you want to start DacEasy independent of the Business Center, refer to the
Chapter 2, “Getting Started” in the User’s Guide.

From the Programs folder—Click the Start button, point to Programs, point to
DacEasy, and then click Business Center.
From the desktop—DacEasy adds an icon to the desktop if you select this option
during the Setup routine. If you selected this option, double-click the DacEasy
Business Center icon on your desktop to start the program.
From the Start menu—DacEasy adds an entry to the Start menu if you select this
option during the Setup routine. If you selected this option, click the Start button,
and then select DacEasy Business Center.

After you start the Business Center, the next step depends on the type of user you are.

New Users—If you are a new user of the program, you have to add a company
profile. The first time you access the Business Center the Welcome to DacEasy
dialog box appears. Select an option from the screen.  Refer to the section titled
“Adding New Company Profiles” later in this chapter if you select to create a new
profile. Refer to the section titled “Opening Company Files” later in this chapter if
you select to add an existing profile. When the Create New Profile User dialog
box appears, enter a user name and password. The password is optional. For more
information on your profile user name, refer to the section titled “Setting Up a
Security Passport.”

Upgrade Users—If you are upgrading from a previous version, refer to the
following section titled “Upgrading From a Previous Version.”



DacEasy Installation & New Features Guide         15

Installing

Installing DacEasy   Chapter 1

If you are not using the Business Center, you can access a DacEasy module using the
Programs folder on the Start menu. To access a DacEasy module, click the Start button,
point to Programs, point to DacEasy, point to Modules, and then click the modules you
want to access.

Tip  For steps on creating a shortcut to each DacEasy module on your desktop, refer to the
DacEasy module’s Help system.

If you are using the Business Center, the first time you select a task for a particular
DacEasy module, you are asked to register that module. If you are not using the Business
Center, the first time you access a DacEasy module, you are asked to register that module.
If you choose Yes, the Serial Number dialog box appears. Type your serial number and
activation key using all capital letters, and then click OK. Choose No if you want to
register at a later time. You will continue to receive this message each day when you access
a module for the first time until you register; however, you are not required to register until
the trial period expires.

Tip  The serial number appears on the User’s Guide for each module. Read the Serial
Number dialog box for instructions on obtaining the activation key.
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Upgrading From a Previous Version
If you are upgrading from a previous version of DacEasy, you must convert your data files
to reflect the new file structure. When you add a company profile with existing Version 11
or later data files, DacEasy converts the data files to Version 14.

If you include multiple DacEasy modules in the company profile, converting your data files
from the Business Center helps ensure a successful conversion. DacEasy converts the data
files in the proper order after confirming that all steps required to successfully convert your
data have been performed.

Note  If you are upgrading from a version prior to DacEasy Version 11, you cannot convert
directly to Version 14. The files needed to convert to Version 14 are included on the
DacEasy Version 14 CD. To view the instructions, browse to the \\Utility\Convert folder
and view the Readme.doc file in each of the applicable program subfolders. Follow the
instructions in the Readme.doc file to convert to Version 11, and then complete the
following steps to convert to Version 14.

Before installing Version 14, complete the following checklist to prepare your data files for
conversion.

Conversion Preparation Checklist
Post all transactions, in all DacEasy programs, for each company.

Run the Recover and Verify file utilities on all files, in all DacEasy
programs, for each company.

Back up all companies in all DacEasy programs.

Print all reports that are useful in verifying a successful conversion. For
example, the Aging Reports for Accounts Receivable and Accounts
Payable, Product History Report and Trial Balance are useful for
verifying a successful DacEasy Accounting conversion.

Install DacEasy Version 14.

After preparing your existing data files to be converted, you can begin the conversion
process. When you add existing Version 11 or later data to your company profile, the Add
Module wizard includes a Convert Files screen. From this screen, you have the option to
delete previous data files after conversion. This conserves space on your hard disk drive. If
you have a good backup of your data files, you do not need to keep these files. If you
choose to keep the files on your hard disk drive, the data files remain in the same folder
with new extensions, V11, V12 or V13 depending on the version you are upgrading.
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As DacEasy converts your files, a status of the current file and record appears. After
converting your files, the Recover process is automatically performed to convert the files to
the correct file format. The length of time it takes to convert your files depends on the
number of records in your data. The process normally only takes a few minutes, but expect
longer times for large data files.

After converting your data, print your usual reports to verify a successful transfer of data. If
your data appears as it should, you are ready to use your new software to process your daily
entries. If your data is incomplete, contact Customer Support Services.

For more information on adding the data to a company profile, refer to the following
section. If you would like to move your data folders to a new location after converting,
refer to the section titled “Moving Your Data Files” in this chapter.

Important  We strongly recommend that you use the DacEasy Business Center to convert
your data. If you do not use the Business Center, DacEasy converts your files when you
open the company in the Version 14 module. If you are not using the Business Center and
you are interfacing DacEasy add-on modules with DacEasy Accounting, it is imperative
that you convert DacEasy Accounting data files prior to converting your add-on module
data files.
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Adding New Company Profiles
You must add a company profile for each company you want to access through the
Business Center. Company profiles identify all data files for a particular company.

You can include existing data or create new data when setting up company profiles. If you
are upgrading from a previous version, refer to the section titled “Upgrading From a
Previous Version” in this chapter prior to adding your profile. Complete the following steps
to add a new company profile.

To Add a New Company Profile
1. Start the Business Center. Enter your user name and password on the

Company Profile Logon dialog box.

2. Select New from the Profile menu. The New Company Profile dialog
box appears.

Figure 3-1: Add new company profiles using the New Company Profile dialog box.

Note  If the Business Center is unable to locate an existing company
profile, the Welcome to DacEasy dialog box appears. Select the Create
New Profile option, and then the New Company Profile dialog box
appears.



DacEasy Installation & New Features Guide         19

Installing

Installing DacEasy   Chapter 1

3. Type a unique name to identify the company profile. This name is used to
identify the company when opening your company profile and appears on
the Business Center status bar.

4. Type the path where the new company profile is to be located. This folder
stores information specific to the company profile; therefore, each profile
must be located in a different folder.

When you add new data, the data files are stored in a subfolder in the
profile’s folder unless you change the default. For example, assume  you
type C:\DacEasy\BC\Profiles\MyData as the profile path. If you add new
accounting data, the default path is C:\DacEasy\BC\Profiles\MyData\AC.
We recommend that you accept the default structure to help organize your
data files.

5. Complete all applicable fields in the Company Information area.

6. Click Save. The Create New Profile User dialog box appears.

7. Confirm your password, and then click OK. The Add Module Wizard
appears.

Note  If you are a new user, you have to set up your user name and
password.

8. Follow the instructions on the screen to add the data files to the company
profile. Use the Back and Next buttons to navigate through the wizard.
Click Finish when you have completed the wizard.

Tip  You can browse for an existing company when you add your
company data files. Click Browse, and then click Existing companies to
locate existing DacEasy company folders or click Windows folders to
search all folders.
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A Summary screen lists each module that will be added to the company
profile. If you add existing data for multiple modules, you have the
option to update the company information in each module with the
company information entered for the profile. In addition, you must
interface all modules in the profile with your DacEasy Accounting data
files.

A Complete screen appears when the selected modules have been added
to the profile.

9. Click OK. DacEasy opens the profile and returns you to the Business
Center main menu.
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Moving Your Data Files
Each DacEasy module installs into a subfolder in the destination folder selected during
Setup. The default destination folder is labeled DacEasy. If you converted existing DacEasy
data files to Version 14, you might decide to move your data files to a folder in your
program folder. This allows you to keep all of your DacEasy files in one central location.

The following steps explain how to move your files to a new location if you are using the
Business Center. If you have not already set up a company profile, create a profile before
completing these steps. Refer to the “Adding New Company Profiles” section earlier in this
chapter for more information on adding company profiles.

Note  If you are not using the Business Center, it is important that you first copy (not
move) your data files to the new location, and then add the company in DacEasy with the
new path. If you have moved accounting data that is interfaced with DacEasy add-on
modules, you must update the interface path in the add-on modules. Afterwards, you can
remove the company with the old path from DacEasy, and then delete the files in the old
folder from your hard disk drive. Refer to the User’s Guide if you need assistance with
adding or deleting companies.

To Move Your Data Files
1. Copy the data files from the existing folder to the new location. For

example, if your accounting data files were located in C:\Dea4\Files, you
will to copy them to C:\DacEasy\BC\Profiles\Furniture\AC.

Note  If you are not familiar the procedure of moving files, refer to the
documentation included with your operating system for assistance.
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2. Select Open from the Profile menu in the Business Center, and then open
the company profile that contains the data files you moved. An error
appears, “Unable to locate Version 14 data files.”

3. Select the check box at the bottom of the screen to remove the modules
from the company profile and click Continue.

Note  If the check box is unavailable, you have to remove the profile,
and then add the profile back to the Business Center with the correct
paths to the module data. Refer to the “Removing Company Profiles”
section in Chapter 5, “Working With the Business Center” for more
information on removing a profile.

4. Select Edit from the Profile menu, and then select Add Module. The
Add Module Wizard appears. Select all modules for which the data files
were moved and add the path to the new location.

5. Select Edit from the Profile menu, and then select Company
Information. Click the Paths tab and confirm that each module is
accessing the data files in the new location.

Exiting the Business Center
To exit the Business Center, choose Exit from the Profile menu. You can also exit the
DacEasy Business Center by clicking the Close button located on the DacEasy Business
Center title bar.

Note  Any open windows remain open when you exit the Business Center. You can leave
each DacEasy module window open as needed. Close each window individually when you
are done with the task by clicking the Close button.
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Using the Sample Company
The sample company is data provided by DacEasy to help you become familiar with the
program. The sample data is stored in a Sampdata folder in each program folder unless you
run a custom setup and do not select the Sample Company component. For example, the
path to the accounting sample data is C:\DacEasy\AC\Sampdata if you accepted the default
path.

Tip  If you did not install the sample data but want to use it now, run the Setup routine
again and select the Modify option. Select the Sample Company component for each
module. Then, set up a profile for the sample company.

Opening the Sample Company
The first time you start the Business Center the Welcome to DacEasy dialog box appears.
To open the sample company profile, select the Open sample profile option. This
automatically opens the sample company for you. Afterwards, select Open from the Profile
menu, and then select Sample Company to open the sample company.

If you are an existing user of the Business Center and want to add the sample company,
create a new profile pointing to the sample data for each module you want to use.

To set up the sample company if you are not using the Business Center, add a new company
in the appropriate DacEasy module. In the Path field, type the path to the sample company.
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Setting Up a Security Passport
You are prompted for a user name and password the first time you open a company profile.
The user name and password you add are stored as your passport.

The passport includes a ticket for each module in the company profile. The ticket can store
the User ID and password for each module. Tickets are useful if you activated the Security
feature in the modules. If you choose to store this information in your passport, you only
have to enter a single user name and password when opening a company profile. When you
select a DacEasy function, DacEasy applies the appropriate ticket. DacEasy confirms that
the user ID and password are valid, and that you have rights to the selected function.

Figure 3-2: If you are using the Security feature, you must provide a ticket to access each module. You
can include the ticket with your passport or provide the ticket when you access the module.

3. Click Save to save your passport tickets.
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Setting Up Passport Tickets
The following steps explain how to set up passport tickets. You are not required to set up
passport tickets. However, if you choose not to set up passport tickets, the Enter Ticket
dialog box appears the first time you access a module using the Security feature (during the
current session of the profile). If you select the Update Passport check box on the Enter
Ticket dialog box, the Passport is updated with the ticket information. If you clear the
Update Passport check box, the Enter Ticket dialog box continues to appear the first time
you access the module after opening the profile.

Note  You do not need to set up your passport if you added existing company data files to
the profile and the company is using the Security feature. The Add Module wizard prompts
you for your passport information before adding the company to the profile.

To Set Up Passport Tickets
1. Select Edit from the Profile menu, and then select Passport. The Edit

Passport dialog box appears.

Figure 3-3: Speed entry into each module by adding your user name and password
for each module to your passport.

2. Type your User ID in the User Name field and password for each module
in this company profile.

Note  Payroll’s Security feature does not use User IDs; therefore, the
User Name field is unavailable for Payroll.

3. Click Save to save your passport tickets.
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Changing the Business Center Password
You assign a password to your passport the first time you add yourself as a new user.
Complete the following steps if you want to change the password assigned to your
passport.

Note  If you want to add a new user to an existing profile, type the new user name in the
User Name field on the Open Company Profile dialog box, select the profile, and then
click Open. You are prompted for the new user’s password.

To Change the Business Center Password
1. Select Edit from the Profile menu, and then select Passport. The Edit

Passport dialog box appears.

2. Type a new password in the Business Center area, and then confirm the
entry.

3. Click Save to update your passport with your new password.
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Setting the Controller Password
The controller is the only user that has access to the Company Profile User List dialog
box. From this dialog box, you can view users, remove users, update a user’s full name and
add comments. Refer to Chapter 5, “Working With the Business Center” for more
information on modifying user information.

To Set the Controller Password
1. Select Edit from the Profile menu, and then select Users. The Company

Profile User List dialog box appears.

Note  If the controller password has been saved, a password prompt
appears. Type the controller password and click OK to continue.

Figure 3-4: Edit User information and set the controller password from the Company
Profile User List dialog box.

2. Click Set Password in the Controller Password area. The Set Password
dialog box appears.

3. Type the password, and then confirm the password.

4. Click OK to save your new password. The Company Profile User List
dialog box appears.

5. Click Cancel to return to the Business Center.
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Opening Company Files
One advantage of using the Business Center is that you do not have to close a profile before
opening a different profile. If you have windows open for the current profile, and then open
a different company profile, all new selections are for the most recently opened profile;
however, you can still view windows opened from the previous profiles. The following
steps explain how to open a different company profile.

Tip  The most recently opened company profiles are listed on the Profile menu. You can
click any profile listed to quickly open the company.

To Open a Company Profile
1. Select Open from the Profile menu. The Open Company Profile dialog

box appears.

Figure 3-5: Access the Open Company Profile dialog box to open
a new profile or log on as a different user.

2. Select the profile you want to open. If the profile is not listed, you can
click Browse to locate the profile.

Tip  Click a column heading to sort on the corresponding column.
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3. If you do not want to open the profile with the current user name, type a
different user name in the User Name field.

Tip  If you want this profile to open each time you start the Business
Center, click Default.

4. Click Open. The Business Center opens the selected profile.

Note  If you opened the profile with a different User Name, you are
prompted for your password information.
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Chapter 2

Software Conventions

DacEasy is designed to use standard Windows guidelines. If you are familiar with other
Windows applications, you will find DacEasy easy to use. If you are unfamiliar with using
Windows-based software, please refer to the documentation included with your operating
system to familiarize yourself with the conventions that are used in the program.

Most options in DacEasy can be accessed with the mouse or with the keyboard. Function
key equivalents are the same as in earlier versions. When you point to a button on the
toolbar, the function key equivalent, when available, appears as a ToolTip. Either click the
button with the mouse or press the specified function key.

Tip  If you prefer to use the keyboard instead of the mouse, press the Alt key to make the
main menu active.
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Figure 1-1: This graphic highlights some of the features available on dialog boxes throughout DacEasy.
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User Assistance

At DacEasy, we want you to get the most out of your new software. We understand that
different people have different needs and that is why we offer a number of resources to
assist you in using our product. The Installation and New Features manual  assists you
with installing the program, converting your data if necessary, and features that are
common to all DacEasy programs. The User’s Guide, in combination with the Help system
in the program, provides you with the answers to your questions and is always available. If
you prefer more one-on-one assistance, you can contact Customer Support Services. For
more personal assistance, you can contact a Certified Consultant and arrange for on-site
support or classroom training.

This chapter explains each option in detail. Choose the resource that is best suited to your
needs.

A
ssistance
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Documentation
The documentation set includes online Help, a Installation & New Features Guide and a
User’s Guide. Use these resources to discover the power of DacEasy.

Online Help
The most powerful resource available is also the easiest to use and access. The Help
included in DacEasy can be used for context sensitive help or procedural help. Context
sensitive help allows you to click Help (or press F1) from any field in DacEasy programs,
such as Accounting or Payroll, to view information about the field or dialog box.
Procedural help details the steps involved in a process or answers a question you might
have about the software. To access procedural help; select Contents and Index from the
Help menu (or press Shift+F1). Three tabs appear: Contents, Index and Find (or Search).
A fourth tab, the Favorites tab, appears if you are viewing the Business Center Help.
Locate the answers to your questions using any tab. Following is an explanation of each
tab.

Using the Contents Tab
Use the Contents tab as you would use the table of contents in a book. Related Help topics
are grouped together and appear as a book. Double-click a book to “open” the book and
view its contents. Double-click a topic to view the information associated with the topic.

Using the Index Tab
Use the Index tab as you would use the index in a book. Type a topic description or use the
scroll bar to search the list. The index is designed to be as thorough as possible. Double-
click a topic to view the information. If multiple topics exist, select a topic from the list that
appears.

Using the Find or Search Tab
Click the Find tab to locate each Help topic associated with a particular subject. This tab is
labeled Search in the DacEasy Business Center Help. DacEasy searches the entire Help
system and displays each topic that contains the keywords you specify.

Using the Favorites Tab
Click the Favorites tab to add frequently used Help topics to your Favorites list. This tab is
only available in the DacEasy Business Center Help. When you find Help topics that you
like, you can keep track of them using the Favorites list, so it’s easy to open them in the
future. To add a Help topic to the Favorites list, view the Help topic, and then click the
Favorites tab. The title of the Help topic appears as the Current Topic. Click Add and the
topic appears in the Favorites list
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How Do I?
Another valuable Help tool is the How do I? button available on the title bar of certain
dialog boxes throughout the program. Click How do I? and a menu appears listing
commonly asked questions about the current dialog box. Select any question from the list
to view a Help topic that answers the question.

Documentation Conventions
Documentation provided with your DacEasy products uses several standard conventions to
help quickly identify the actions you need to take to perform an operation. As much as
possible, these conventions are used consistently in all DacEasy documentation.

Actual keys or buttons you press appear in bold type. For example, if you need to
click the OK button to save a transaction, OK appears in bold type as shown in
this sentence.
Menu names and commands that you need to select appear in bold type. For
example, if you need to open a new company by accessing the Open command
from the File menu, the instructions read as follows: Select Open from the File
menu.
Often, you can use either the keyboard or your mouse to perform an action. If this
is the case, a generic word, such as choose or select, is used to instruct you to
perform the action. For example, the above instruction “Select Open from the File
menu” uses “select.” This indicates you can use the mouse to click on File, and
then Open or you can use your keyboard. To use the keyboard, press Alt+F to
view the File menu, and then use the down arrow key to select Open on the File
menu. Press Enter to access the Open Company dialog box.
“Click” means to quickly click the left mouse button once.
“Double-click” means to quickly click the left mouse button twice.
“Point” means to position the mouse pointer on a field or button.
Procedures with steps appear as numbered lists. A heavy line that appears above
the title easily distinguishes these steps.
Most screens have multiple fields in which you can enter information. The
manuals are designed to work hand-in-hand with the Help system. Click Help
from a field to get an explanation of the field.
Underscores within text indicate you should type spaces. For example, if you need
to place a space within text, it would be printed as follows: Copy_A:.
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A plus sign (+) between two keys indicates you need to press the first key and hold
it down while you press the second key. For example, to access the File menu
from the keyboard, you might see Alt+F. To perform this action, press the Alt key.
While holding down the Alt key, press the F key.
“Keypad” refers to the numeric keys on the right side of most keyboards. These
keys are directional or movement keys when the NumLock feature is off.
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Additional Resources
In addition to the documentation provided with the software, there are a number of
additional resources you can look to for assistance.

On-Site Support and Classroom Training
Certified Consultants are independent business specialists, trained and certified by DacEasy
to help you determine your business needs. Certified Consultants can tailor DacEasy
programs to fit your exact needs.

Many Certified Consultants offer both on-site and classroom training, and many are skilled
in setting up and maintaining local area networks.

Call (800) 305-2556 or visit our Web site at www.daceasy.com to obtain a list of Certified
Consultants in your area.

Online Support
If you have access to the World Wide Web, you can get e-mail support by accessing our
home page at www.daceasy.com. Include your credit card number, or customer ID if you
have a support plan, with your question to receive a response via e-mail. Responses are
usually sent within 24 hours, during regular business hours.

Telephone Support
DacEasy understands that your time is valuable. For fast answers to your questions, contact
our Customer Support Services team. Customer Support Services has developed various
resources to provide solutions for our customers. A description of DacEasy telephone
support options follows. Choose the option that best meets your needs.
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Support Options*
DacEasy has several support options available to benefit our customers whose preferred
method of assistance is telephone support. Support plans provide our customers with an
economical method of technical support along with additional benefits.

The support brochure included in the package details each support option. Please take a
minute to review this brochure and discover the many benefits available to you. For more
information, call our Sales Department at (800) 987-5212.

*Note  Prices, conditions and hours of operation are subject to change without notification.

Preparing for a Support Call
When you place a call to DacEasy Customer Support Services, please help us make our
support as efficient as possible by following these guidelines:

Please be at your computer when you call for support. It is usually necessary to
recreate the incident or walk through a series of steps to solve technical problems.
If an error occurred during a posting or periodic routine, it is necessary to restore
the backup, and then correct the error. Please have the data restored before you
call the support lines.
If you received an error message, it is important that you have the exact wording
of the message and the area of the program in which it occurred.
Gather information specific to your system. For steps on gathering system
information, refer to the Help topic “Preparing for a Support Call.”
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This chapter highlights each of the new powerful features available in DacEasy V14. It also
describes detailed procedures that are necessary to start using these new features.

In addition to this information, the on-line help provides detailed descriptions of  each field
in DacEasy. The help system also includes procedural Help topics to guide you through the
steps involved in completing each process. This includes advanced features not covered in
the printed documentation. For more information on the documentation, refer to chapter 2,
“User Assistance.”

This chapter contains descriptions of new features that have been added or areas that have
been updated in DacEasy V14. The features are listed by modules.

D
acEasy V14 Features
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Business Center

Transaction Register with Drill Down

Instant Reports provide quick access to key reports in DacEasy modules and the ability
to view the associated detail by drilling-down on vital information. In Version 14, this
popular feature has been improved with printable views of reports and more drill-down
reports on Customer, Vendor, and Inventory directories. Locate the information quickly
and easily with the ability to navigate from a summarized view of data to more detail such
as customer purchase history. In addition, the new Printer Friendly View allows Instant
Reports to be redirected to the printer, Excel or html, or exported to ASCII comma
delimited or text.

Instant Reports Printer Friendly View

1. Click Instant Reports on the Navigation bar in the Business Center workspace.
The Accounting Instant Reports page appears in the Contents area. To select a
different module, click the appropriate module on the Contents bar.

Tip Point to a report name to view a description of the report with a sample. You
can click the sample report to enlarge the image, and then click the Back button
on the Explorer toolbar after viewing the sample to return to the Instant Reports
page.
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2. Click the report name. The report appears in the workspace.

       Note If the report name appears dimmed, the module is either not installed or is
        not included in the company profile.

3. Click on the Printer Friendly icon on the report footer and the Report Layout
dialog appears.

Figure 3-1:   Instant Report with Printer Friendly Icon.

4. Select the Target Disposition in the Report Layout Dialog and click OK to view
the report.

Tip Change the options in the Report Layout Dialog to modify the report layout
if necessary.
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5. If necessary, exit the Target Disposition to return to the Instant Reports.

Viewing the Customer Directory

1. Click Instant Reports on the Navigation bar in the Business Center workspace.
The Accounting Instant Reports page appears in the Contents area.

2. Click on Customer Directory and the report will appear in the workspace area of
the Business Center.

Note Click on the icon to the left of the report name to view and modify the
available report options.

Tip For more information on the available report options Click on help or press
F1 from the options dialog.

Drill down to the Customer Directory detail

1. Click on any Customer Code in the Customer Directory to drill down to the
Edit Customer Dialog. Use the Edit Customer Dialog to view or edit detail
information for that customer.

Tip Use the toolbar options in Edit Customer to enter an invoice or view and
print the customer’s transaction history.

2. Click on any Account Number in the Customer Directory to drill down to the
Edit Account Dialog.

3. Click on any Customer Name in the Customer Directory to drill down to the
Purchase History report for that customer.
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4. Click on the Balance for any customer to drill down to the customer aging
information. The customer aging appears in the Business Center Workspace.

Viewing the Vendor Directory

1. Click Instant Reports on the Navigation bar in the Business Center workspace.
The Accounting Instant Reports page appears in the Contents area.

2. Click on Vendor Directory and the report will appear in the workspace area of
the Business Center.

Note Click on the icon to the left of the report name to view and modify the
available report options.

Tip For more information on the available report options click on help or press
F1 from the Options dialog.

Drill down to the Vendor Directory detail

1. Click on any Vendor Code or Vendor Name in the Vendor Directory to drill
down to the Edit Vendor Dialog. Use the Edit Vendor Dialog to view or edit
detail information for that vendor.

Tip Use the toolbar options in Edit Vendor to create notes or view historical
information for that vendor.

2. Click on any Account Number in the Vendor Directory to drill down to the Edit
Account Dialog.
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3. Click on the Balance for any vendor to drill down to the vendors aging
information. The vendor aging appears in the Business Center Workspace.

4. Use the Business Center navigation arrows to return to the Vendor Directory.

Viewing the Product Catalog

1. Click Instant Reports on the Navigation bar in the Business Center workspace.
The Accounting Instant Reports page appears in the Contents area.

2. Click on Product Catalog and the report will appear in the workspace area of the
Business Center.

Note Click on the icon to the left of the report name to view and modify the
available report options.

Tip For more information on the available report options Click on help or press
F1 from the options dialog.

Drill down to the Product Catalog detail

1. Click on any Item Code or Item Name in the Product Catalog to drill down to
the Edit Product Dialog. Use the Edit Product Dialog to view or edit detail
information for that item.

Tip Drill down to the Edit Product Dialog to view that product’s image or to
create notes for that product.
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2. Click on the average or standard cost for any item to drill down to the item’s
Activity Detail Report.

Note The Track Product Transaction History option must be enabled in
System Preferences to obtain the Activity Detail Report.
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Accounting, Payroll, Order
Entry, Point-of-Sale

Audit Trail

Improve auditing and defend against potential fraud. With this feature, you have a register
of user activity in the system. Audit Trail records insertions, deletions, and modifications
of the most relevant master and transaction tables in DacEasy. This important
enhancement to the security system maintains a record of who modified the information in
your system, as well as what information was modified and when.  The log is available to
print as you desire. You can also keep a record of the date and time of all changes to the
Payroll Employee file and the Tax Tables.

Note To activate the Audit Trail Log in the Accounting, Order Entry and Point-of-Sale
modules, enable the Activate User Access Rights option in System Preferences. To
activate the Audit Trail Log in the Payroll module enable the Generate Audit Trail
check box in Preferences.
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The Audit Trail Log Report gives a detailed listing of the Audit Trail records that exist for
any of the DacEasy modules where this feature is activated. You can filter this report by
any of the Sort and Rank options available, which include Date, User ID, and Entity ID.
This allows you to print a report showing for any entity all the activity in DacEasy for a
range of Dates and User ID’s. You may also choose the specific functions for which you
want to monitor this activity.

Note Since Payroll uses a different security system, the User ID is omitted from its audit
trail sorting and ranking options.

Turning ON User Access Rights

1. Select Defaults from the Edit menu, and then select Passwords. The Edit
Password dialog box appears.

2. Type the password to be used each time you log in as the Controller.

Tip This is a Master password that allows access to every function in the system.
It is important to remember this password or write it down and store it in a secure
place.

3. Type the password again in the Confirm Password field.

       Tip For more detailed information on creating users on the  refer to the User’s
Guide for each module or to the on-line help system.
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4. Select Defaults from the Edit menu, and then select User Access Rights. The
Edit User Access dialog box appears.

5. Type a User ID and Password, and then confirm the password. If you are editing
an existing user, Click LookUp to select the user.

6. Select the Limit Warehouse check box if you have multiple warehouses and
want to limit  the one for which the user can purchase or sell inventory. If you
have set up your warehouses and you selected to Limit Warehouses, click on
Options and then select Edit Warehouse Permits to tag the warehouses that are
available to this user.

7. Click on Edit User Permits and the User Access Rights dialog box appears.
Select a function and click on Tag/Untag to give or remove access to the
highlighted function. You may use Tag/Untag All to assign or remove access to
all the listed functions.

8. Click OK to save the user, and exit this function when you have completed
creating your users.

9. Select Defaults from the Edit menu, and then select System Preferences. The
Edit System Preferences dialog box appears.

10. Select the Activate User Access Rights check box to enable the Security System
and press OK to save the system preferences.
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Turning ON the Audit Trail Log

1. Select Defaults from the Edit menu, and then select System Preferences.

2. Click on the Generate Audit Trail Log check box to enable this option.

3. Click OK to save the new preference settings or Close to exit without saving.

Creating the Audit Trail Log

DacEasy creates an Audit Trail record every time users perform certain types of actions
such as Inserting, Updating or Deleting information, using any of DacEasy’s Transaction
Entry or Table Maintenance functions. The Audit Trail record includes the date and time
of the action, the ID of the User who performed the action, the ID and description of the
entity affected by the action, the type of action performed (Insert, Update, Delete), and a
reference to the source transaction.

Note Entities refer to the Transaction Entry or Table Maintenance functions available in
DacEasy. Examples of entities are General Ledger, Accounts Receivable and Accounts
Payable transaction entry. Since Payroll uses a different security system, the User ID is
omitted from its audit trail.
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The following list describes the entities and activities that generate an Audit Trail, and the
modules that include them. Interfaced modules that share an entity only maintain one
Audit Trail log. Example, Customer Entity when Point-of-Sale and Accounting modules
are interfaced.

Module Entity ID Description Reference
ACCTG Account Edit Accounts Account Number
ACCTG,POS,OE Customer Edit Customers Customer Code
ACCTG,POS,OE Vendor Edit Vendors Vendor Code
ACCTG,POS,OE Product Edit Products Item Code
ACCTG,POS,OE Service Edit Services Service Code
ACCTG,POS,OE Master Item Edit Master Items Master Item Code
ACCTG Fixed Asset Edit Fixed Assets Fix Asset Code
ACCTG Purchasing Code Edit Purchasing Codes Purchase Code
ACCTG,POS,OE Billing Code Edit Billing Codes Billing Code
ACCTG,POS,OE Salespeople Edit Salespeople Salespeople Code
ACCTG,POS,OE Message Edit Messages Message Code
ACCTG,POS,OE Price Break Edit Price Breaks Price Break Code
ACCTG,POS,OE Shipping Method Edit Shipping Methods Shipping Method Code.
ACCTG,POS,OE Term Edit Terms Term Code
ACCTG,POS,OE Tax Edit Taxes Tax Code
ACCTG,POS,OE Warehouse Edit Warehouses Warehouse Code
ACCTG,POS,OE Weight Unit Edit Weight Units Weight Unit Code
ACCTG General Ledger GL Transactions GL-<Transaction #>.
ACCTG Accounts Receivable AR Transactions AR-<Transaction #>
ACCTG Accounts Payable AP Transactions AP-<Transaction #>
ACCTG Cash Receipt Receipts Transactions <Transaction #>
ACCTG Cash Autopay Autopay Generate <Transaction #>
ACCTG Cash Payment Payment Transaction <Transaction #>
ACCTG Cash Adjustment Cash Adjustments <Transaction #>
ACCTG Reconciliation Bank Reconciliation RECON-<MM-DD-YYYY>
ACCTG Void Checks Cash Void Checks <Transaction #>
ACCTG Merchandise Receipt Purchase Receipts Entry <MR Number>
ACCTG Merchandise Return Purchase Returns Entry <PR Number>
ACCTG,OE Invoice Invoices Entry <Invoice #>
ACCTG Sales Return Sales Return Entry <SR Number>
ACCTG,POS,OE Inventory Inventory Adjustments <Transaction #>
ACCTG,POS,OE Assembly Assembly Transactions <Transaction #>
ACCTG Physical Inventory Physical Inventory <Transaction #>
POS Sales Register Sales Register Entry <Receipt #>
OE Orders Orders Entry <Order #>
PAYROLL Employee Edit Employees Employee Code
PAYROLL Federal Tax Edit Federal Tax Table Tax code
PAYROLL Local Tax Edit Local Tax Table Tax Code
PAYROLL State Tax Edit State Tax Tax Code
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Printing the Audit Trail Log

1. Choose Audit Trail Log from the Reports menu for the Accounting, Point-of-
Sale or Order Entry modules.

2. Enter the Sort by and Rank by options.

Figure 3-2: Audit Trail Log Report options dialog.

3. Click OK. The Report Layout dialog box appears.

4. Select the target disposition, edit the layout if necessary, and then click OK to
begin printing.
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Figure 3-3: Audit Trail Log Report.

Purging the Audit Trail Log

1. Select Purge from the Periodic menu and the Purge dialog box appears.

2. Open the File dropdown and choose Audit Trail Log.

3. Enter the ‘purge to’ date.

Note This function purges Audit Trail records with a date equal to or earlier
than the ‘purge to.’

4. Press OK to start purging.

Note Purging physically removes records from your company data. You must
make sure this is what you want to do before performing this task.
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Accounting, Order Entry, Point-
of-Sale

Active/Inactive Status
Reduce the time that it takes you to lookup vendors, customers, services, and more. When
you set records as inactive, these records are omitted from reports, lookups, and may not
be used when making transactions. Set the status of Accounts, Customers, Vendors,
Products, or Services to Inactive when you want DacEasy to ignore these records
without physically removing them from the company database. You may change the status
of Inactive to Active when you are ready to start using these records again.

Changing the Status of Accounts

1. Select Customers from the Edit menu and the Edit Accounts dialog box appears.

2. Click on LookUp to select the customer to edit.
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3. Click on the Inactive check box field to set the status of that account to Inactive.
An unmarked check box means that the status is set to Active.

Note DacEasy verifies that it can change the status of an account to Inactive
without causing integrity problems to your company’s database. If the account
does not meet this validation criteria DacEasy displays an error message.

4. Click OK to save the account or Click CLOSE to exit without saving.

Purging Inactive Accounts

1. Select Accounts from the Edit menu and the Edit Accounts dialog box appears.

2. Click on Options in the Edit Accounts toolbar and then Click on Purge
Inactive.

Note The Purge Inactive function removes all Inactive accounts from the Chart
of Accounts. You must be sure that this is what you want to do before running the
Purge Inactive option.

3. Click on Continue to delete Inactive accounts or Cancel to stop this process and
return to the Edit Accounts dialog.

Figure 3-4: Purge Inactive confirmation dialog
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Changing the Status of Customers

1. Select Customers from the Edit menu and the Edit Customers dialog box
appears.

2. Click on LookUp to select the customer to edit.

3. Click on the Inactive check box field to set the status of that customer to
Inactive.  An unmarked check box means that the customer is set to Active.

       Note DacEasy verifies that it can change the status of a customer to Inactive
without causing integrity problems to your company’s database. If the customer
does not meet this validation criteria DacEasy displays an error message.

4. Click OK to save the customer or click CLOSE to exit without saving.

Purging Inactive Customers

1. Select Customers from the Edit menu and the Edit Customers dialog box
appears.

2. Click on Options in the Edit Customers toolbar and then Click on Purge
Inactive.

       Note The Purge Inactive function removes all Inactive customers from the
Customers table. You must be sure that this is what you want to do before
running the Purge Inactive option.

3. Click on Continue to delete Inactive customers or Cancel to stop this process
and return to the Edit Customers dialog.
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Changing the Status of Vendors

1. Select Vendors from the Edit menu and the Edit Vendors dialog box appears.

2. Click on LookUp to select the vendor to edit.

3. Click on the Inactive check box field to set the status of that vendor to Inactive.
An unmarked check box means that the status is set to Active.

Note DacEasy verifies that it can change the status of a vendor to Inactive
without causing integrity problems to your company’s database. If the vendor
does not meet this validation criteria DacEasy displays an error message.

4. Click OK to save the vendor or Click CLOSE to exit without saving.

Purging Inactive Vendors

1. Select Vendors from the Edit menu and the Edit Vendors dialog box appears.

2. Click on Options in the Edit Vendors toolbar and then Click on Purge Inactive.

Note The Purge Inactive function removes all Inactive Vendors from the
Vendors table. You must be sure that this is what you want to do before running
the Purge Inactive option.

3. Click on Continue to delete Inactive Vendors or Cancel to stop this process and
return to the Edit Vendors dialog.

Changing the Status of Products

1. Select Products from the Edit menu and the Edit Products dialog box appears.

2. Click on LookUp to select the Product to edit.
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3. Click on the Inactive check box field to set the status of that Product to Inactive.
An unmarked check box means that the status is set to Active.

      Note DacEasy verifies that it can change the status of a Product to Inactive
without causing integrity problems to your company’s database. If the Product
does not meet this validation criteria DacEasy displays an error message.

4. Click OK to save the Product or click CLOSE to exit without saving.

Purging Inactive Products

1. Select Vendors from the Edit menu and the Edit Products dialog box appears.

2. Click on Options in the Edit Products toolbar and then Click on Purge
Inactive.

Note The Purge Inactive function removes all Inactive Products from the
Products table. You must be sure that this is what you want to do before running
the Purge Inactive option.

3. Click on Continue to delete Inactive Products or Cancel to stop this process and
return to the Edit Products dialog.

Changing the Status of Services

1. Select Services from the Edit menu and the Edit Services dialog box appears.

2. Click on LookUp to select the Service to edit.

3. Click on the Inactive check box field to set the status of that Service to Inactive.
An unmarked check box means that the service is set to active.
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Note DacEasy verifies that it can change the status of a Service to Inactive
without causing integrity problems to your company’s database. If the Service
does not meet this validation criteria DacEasy displays an error message.

4. Click OK to save the Product or click CLOSE to exit without saving.

Purging Inactive Services

1. Select Services from the Edit menu and the Edit Services dialog box appears.

2. Click on Options in the Edit Services toolbar and then Click on Purge Inactive.

Note The Purge Inactive function removes all Inactive services from the
Services table. You must be sure that this is what you want to do before running
the Purge Inactive option.

3. Click on Continue to delete Inactive Services or Cancel to stop this process and
return to the Edit Services dialog.
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Incorporate Images to Reports and Forms
Strengthen your company’s image and branding with more professional looking forms and
reports. Now you may include your company logo on reports and forms. In addition, this
feature may reduce your company’s expense of purchasing forms with your company logo
pre-preinted. Simply setup a bitmap image of your company Logo on the Company
Information Dialog of each DacEasy Module and indicate that you want this image to be
printed in the header of all reports. You can also print the logo in your forms by adding the
variable {LOGO} to your form templates. DacEasy V14 supports .bmp, .jpg, and .gif
bitmap extensions.

Setting the Company Logo

1. Select Defaults from the Edit menu and then select Company Information. The
Company Information dialog box appears.

Figure 3-5: Company Information dialog.
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Note The blank placeholder for the Company logo bitmap displays the message
“Click here to select an image.”

2. Click on the bitmap placeholder and the bitmap selection dialog box appears.

Figure 3-6: Bitmap Selection Dialog Box

Note DacEasy copies Bitmaps into an Images folder located inside the company’s
data folder when doing a company backup, this folder is included. This folder is
the default when the bitmap selection dialog box appears. You may locate the
bitmap in other folders in your desktop or network or click OK to copy it to the
Images folder.

3. Enter the path of the folder where the bitmap is located. If necessary, click on the
button to the right of the folder field to find the bitmap in your desktop or
network. The bitmap appears in the dialog box image placeholder.

4. Click OK to associate the bitmap to the Company Information. The bitmap
appears as a thumbnail in the Company Information dialog box.
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5. Click Remove Image to disassociate an exiting bitmap from the Company
Information, or Cancel to stop this operation and exit the bitmap selection
dialog.  (in the Figure 3-6 screen reads Without Image, not Remove Image)

6. Click on the Print bitmap on reports check box if you want the company logo
to appear in all report headers.

Note The Print bitmap on reports check box must be marked to have the logo
print on report headers.

7. Click OK to save the Company Information.

Adding LOGO variable to form templates

In addition to the report header, DacEasy V14 allows you to print your company logo on
the header of your customized forms. You can position the company logo horizontally
across the form header.

Note The LOGO will always print at the top of the form positioned horizontally
on the same column where the variable is placed in the template.

1. Select Defaults from the Edit menu and then select Forms Setup. The Forms
Setup dialog box appears.

2. Select the form that you want to place the logo on from the form dropdown box.

3. Click on Edit and the template editor will appear with the default template for the
form you selected.
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4. Position the cursor on the first row of your form template and Click on LookUp
and then click on Control.  A LookUp of the Control variables appears.

5. Select the variable LOGO from the LookUp and press ENTER to paste it unto the
form template.

6. Click OK to save the template and Close to return to the menu.

Printing Forms with Company Logo

Printing any form containing the LOGO variable in its template will print the Company
Logo image setup in the Company Information dialog.

Note It is not necessary to enable the Print bitmap on reports check box in Company
Information to have the LOGO display in your forms.
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Figure 3-7: Invoice with Company Logo
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 Field Level Security

This feature improves the security of your data and reduces employee mistakes. Keep
unauthorized employees from modifying sensitive fields such as pricing and line item
discounts on Billing and Purchasing WIndows. Use this feature for fields that are pre-
filled with a logical default that users should not be modify, or for toolbar options that
require a higher level of security. Examples of these are the Price field or the Delete
Invoices option in the Invoice form.

In addition, this feature closes known security violations by
disallowing indirect unauthorized user access to certain functions. In previous versions,
once a user entered into certain option for which the user has access, he or she may invoke
other functions for which he or she does not have access.

Note User rights to these fields and toolbar options default to ON when a company is
converted from previous versions of DacEasy.

Assigning Field Level Security

1. Select Defaults from the Edit menu and then select User Access Rights. The
Edit User Access dialog appears.

2. Click on LookUp to select the User you are assigning rights to.

3. Click on Edit User Permits and the User Access Rights dialog box appears.
Find the function or field level security you want and Click on Tag/Untag to give
or remove access to the user.

Tip All new protected functions and fields were added to the end of the list in the
Edit User Permits dialog.
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DacEasy V14 adds field level security to the following fields  and
toolbar options:

Module Form Type Description
Accounting Invoices Toolbar Option Delete Invoices
Accounting Invoices Toolbar Option Edit Bank Account
Accounting Invoices Toolbar Option Edit Deposit
Accounting Invoices Field Billing Price
Accounting Invoices Field Line Discount
Accounting Invoices Field Tax Code
Accounting Invoice Field Total Tax
Accounting Purchasing Field Purchase Price
Accounting Purchasing Field Line Discount
Accounting Purchasing Field Tax Code
Accounting Purchasing Field Delete MR
Accounting Edit Accounts Field GL Account Status
Accounting Edit Customers Field Customer Status
Accounting Edit Vendors Field Vendor Status
Accounting Edit Services Field Service Status
Accounting Edit Product Field Product Status
Point-of-Sale Edit Customers Field Customer Status
Point-of-Sale Edit Products Field Product Status
Point-of-Sale Edit Services Field Service Status
Order Entry Edit Customers Field Customer Status
Order Entry Edit Products Field Product Status
Order Entry Edit Services Field Service Status
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User Access Rights Security

Increase the level of control for current user access rights by assigning add, edit, or delete
rights for defined functions of the application. This feature allows you to determine which
users can perform certain tasks within Account, Customer, Vendor, Product, and Services
functions. The following table describes these rights and the permits they include:

                                   User Rights                     Permissions

                                Edit <Table>                   View, Insert
                                 Modify <Table>               View, Change

     Delete <Table>                 View, Delete

Note <Table> refers to the supported edit functions. These the following: Accounts,
Customers, Vendors, Master Items, Products, Services, Fixed Assets, Terms, Taxes, Billing
Codes and Purchase Codes. The Edit User Permits LookUp includes new entries to
modify and delete each of these tables.  The right to edit a table, found also in previous
versions of DacEasy, allows users to insert new records or view existing records only.

Assigning Access Rights to Edit, Modify or
Delete Tables

1. Select Defaults from the Edit menu and then select User Access Rights. The
Edit User Access dialog appears.

2. Click on LookUp to select the User you are assigning rights to.
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3. Click on Edit User Permits and the User Access Rights dialog box appears.
Find the Edit, Modify or Delete entry for the table you want and Click on Tag/
Untag to give or remove access to the user.

Tip Rights to modify and delete were added to the end of the list in the Edit User
Permits dialog. Rights to Edit retained their original position from previous
versions of DacEasy.

Product Illustration

This feature allows you to incorporate illustrations of products in the Products
Maintenance dialog in order to easily identify items when needed. Now you can view an
image of each product which can reduce mistakes when ordering or selling products that
have similar descriptions and price.  With this powerful improvement your employees can
visually identify a product when they are making changes to that product’s attributes.

1. Select Products from the Edit menu and the Edit Products dialog appears.

2. Click on LookUp to select the Product to edit or enter a new Product code to add
a new one.

3. Click on the image placeholder and the bitmap selection dialog appears.
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Figure 3-8: Edit Product bitmap selection dialog.

Note The blank placeholder for the product image displays the message “Click
here to select an image.” DacEasy copies Bitmaps to the Images folder that it
creates inside the company’s data folder. The Backup function in all modules
includes this folder when doing a company backup. This folder is the default
when the bitmap selection dialog box appears. You may locate the bitmap in other
folders in your desktop or network and Click OK to copy it to the Images folder.

4. Enter the path of the folder where the bitmap is located. If necessary, click on the
button to the right of the folder field to find the bitmap in your desktop or
network. The bitmap appears in the dialog box image placeholder.

5. Click OK to associate the bitmap to the Product. The bitmap appears as a
thumbnail in the Edit Product dialog.
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Figure 3-9: Edit Product Dialog Box with Associated image.

6. Click Remove Image to disassociate an exiting bitmap from the Product
Information, or Cancel to stop this operation and exit the bitmap selection
dialog.

7. Click OK to save the Product Information.
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Promotional Pricing

This popular feature found in DacEasy Point of Sale and Order Entry is now being
brought to the Accounting module. Now you may set up special promotional pricing for
specific items based on a price override, a flat discount, or a percentage discount. Plus you
can create customized price lists for certain customers.

The promotional price feature lets you enter special sales prices that are valid for a certain
range of dates. If you are offering a sale on specific items for one week, enter the sales
price you want for that week on the promotional price transaction dialog. The promotional
price appears on the sales transaction when the transaction date is within the date entered
on the promotional price. Furthermore, you can specify the customers to which the special
promotion applies.

Note The promotional price feature in V14 allows you to specify whether a promotional
price transaction applies to one customer, a range of customers, or all customers.

Entering a Promotional Price

1. Choose Promotional Price from the Edit menu. The Edit Promotional Price
dialog box appears.
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Figure 3-10: Edit Promotional Prices

2. Press Enter and DacEasy assigns the transaction number. Enter the dates the sale
begins and ends in the appropriate fields.

3. Select how you want your products to be grouped when assigning the
promotional prices in the Group By field. If you select Product, Vendor, or
Dept., enter the range in the From Code and To Code fields.

4. Enter a description of the promotional price transaction in the Description field.
This is usually the name of the sale, for example, White sale.

5. Select a method of discounting the product’s normal sale price in the Discount
field.
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6. Enter the flat dollar amount you want discounted off the product’s normal sale
price in the Amount/Percentage field if you selected Flat in the Discount field.

Enter the percentage you want deducted from the product’s normal sale price in
the Amount/Percentage field if you selected Percent in the discount field.

7. Select the Default to Lowest Price check box if you want DacEasy to check for
quantity price breaks. If a customer eligible for a price break can get a lower
price due to the price break discount, the customer is charged the lower price
rather than the promotional price amount.

8. Access the Product Detail grid in the body of the Edit Promotional Price
dialog box. All selected products appear.

Tip Click Options and then select Alt 1 to move to the Product Detail Grid.
Click Options and then select Alt 2 to move to the Customer Detail Grid.

9. If you selected Price in the discount field, enter the sales price you want during
the promotional price period in the Promo Price column.

If you selected Flat or Discount in the Discount field, DacEasy automatically
calculates the new price and displays it in the Promo Price column. You can edit
the Promo Price if necessary.

Tip Click Help for more information on the Edit Promotional Price dialog box.

10. Select the Apply to all customers check box if you want the promotional price to
apply to all customers.

11. Select how you want your customers to be grouped when assigning the
promotional prices in the Group By field. If you select Customer, Billing
Group, Department, City, or State. Enter the range in the From Code and To
Code fields.
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Note Use the Group By, From Code, and To Code fields to filter the customers
that populate the Customer Detail Grid. Select None in the Group By check box
if you want to enter customers one by one.

12. Access the Customer Detail grid in the body of the Edit Promotional Price
dialog box. All selected customers appear.

13. You can add new customers into the Customer Detail Grid by entering the
customer code in the Customer Code column. Click on LookUp to select form a
list of customers.

14. Select Options and then select Line Delete, or press SHIFT F6 to delete a
customer from the Customer Detail Grid.

Printing the Promotional Prices Report
The promotional price listing gives you a list of the transactions entered using the Edit
Promotional Prices dialog box. All items entered with a promotional price stay in the file
until purged using the purge routine.

1. Choose Promotional Price from the Reports menu, or while in the Edit
Promotional Price Click on Report. The Promotional Price Report dialog box
appears.

Figure 3-11: Promotional Price Report Dialog Box.
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2. Enter the Sort by and Rank by information.

Tip Click Help from the Promotional Price Report dialog box for a detailed
description of each field.

3. Click OK. The Report Layout dialog box appears.

4. Select the target, edit the layout if necessary, and then click OK to begin printing.

Figure 3-12: Promotional Price Report.
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Accounting, Payroll

Customizable Checks

Customize checks to your company’s needs by positioning information based on your
bank’s suggestions. You may print checks based on templates defined by you the same
way as invoices, purchase orders and other forms. To use customized checks in DacEasy
Accounting, setup Custom as the check printing option in Edit Forms Setup, and define
the check template to use. You can override the use of the custom template for any
individual bank account.

To use customized checks in DacEasy Payroll setup Custom as the check printing option
in Preferences and define the check templates to use. DacEasy Payroll allows you to use a
template for your employee payroll checks and a different template for your Tax Deposit
checks.

DacEasy V14 stores check templates in a separate file in the data file folder. These files
have an extension of .fmt. When you create a new company or convert from a previous
version, DacEasy assigns a default template automatically. You can edit the default
template or create your own template file, if necessary.

Tip Use the default templates when you want to do minor customizations to your current
DacEasy checks.
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Setting up Customizable Checks in DacEasy
Accounting

1. Select Defaults from the Edit menu and then select Forms Setup. The Edit
Forms Setup dialog appears.

2. Select Checks from the Form dropdown box.

3. Click on the Check Type dropdown box and select Custom as your check
printing option.

Figure 3-13: Edit Forms Setup dialog box

4. Select the Print Comments on Check Stub check box if you want detail line
comments on your payment transaction to print on the check stub.

Note For more information on detail line comments go to the Detail Line
Commenting section of the Installation and New Features Guide. You can
change these options at anytime.
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5. Click on Names and the Format File Names dialog appears. Enter the name of
your check template in the Checks field. Click on LookUp to select from a list of
available templates.

Figure 3-14: Format File Names dialog

6. To create a new template type the template name in the Checks field. To select an
existing template, type the template name or click on LookUp and select the
template.

Tip Select Options and select Copy Format to make a copy of an existing
template.

7. Click on OK to save the Format File Names and return to the Edit Forms Setup
dialog.
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8. Click on Edit to work on your check template. Click OK when you finish
designing or editing your template.

9. Click OK to save your check form settings.

Note Refer to the “Editing templates” and “Template Variables” topic in Help for
more information on how to create or edit form templates.

Overriding Check printing options for each
Bank Account

With DacEasy Accounting V14 you can define the check printing options for each of your
bank accounts. To do this you edit the bank account and select Check Forms from the
toolbar.

When DacEasy prints checks, it looks for the check printing options in the bank account
record. If it does not find any options set up, DacEasy prints checks using the default
configuration setup in Edit Forms Setup.

1. Select Accounts from the Edit menu and the Edit Accounts dialog appears.

2. Click on LookUp to select the account to edit.

3.  Click on Options and then select Check Forms. The Edit Check Options
dialog appears.
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3-13: Edit Check Options Dialog

4. Select the check printing option in the Check Type dropdown box.

5. If you selected Custom as your Check Type, enter the name of the check
template to use for this bank account. Click on LookUp from the Check
Template Name field to select an existing template.

6. If you selected Custom as your Check Type, Select Edit Form from the Check
Template Name field to work on the check template. Click on OK when you
finish creating or editing your template.

7. Select the Print Comments on Check Stub if you want detail line comments on
your payment transaction to print on the check stub.

Note For more information on detail line comments go to the Detail Line
Commenting section of the Installation and New Features Guide.

8. Click OK to save the check printing settings.
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Setting up Customizable Checks in DacEasy Payroll

1. Select Defaults from the Edit menu and then select Preferences. The Preferences
dialog appears.

2. Click on the Payment Settings tab to move to that section in the dialog box.

3-14: Payroll Preferences Dialog – Payment Settings Tab

3. Select Custom from the Check Type dropdown box.

4. Enter the name of your check template in the Employee Check Form field, or
click on LookUp to select from a list of available templates.

5. From the Employee Check Form field select Edit Forms to edit the employee
check template.
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6. Enter the name of your Tax Deposit check template in the Tax Deposit Check
Form field. Click on LookUp to select from a list of available templates.

7. From the Tax Deposit Check Form field select Edit Forms to edit the tax deposit
template.

8. To create an employee check template, type a new name in the Employee Check
Form field. To select an existing template, type the template name or select
LookUp and select the template.

9. To create a tax deposit template, type a new name in the Tax Deposit Check
Form field. To select an existing template, type the template name or select
LookUp and select the template.

Note Refer to the “Editing templates” and “Template Variables” topic in Help for
more information on how to create or edit form templates.

Tip Select Options and select Copy Format to make a copy of an existing
template.

10. Click on OK to save the Preferences and return to the menu.
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Accounting

Filter Audit Report by Past Due Days

With this feature you can manage your Accounts Receivable and Accounts Payable better
and more efficiently. Never before has it been this easy to identify delinquent customers.
This feature provides you the ability to print a list of past due invoices that fall within a
specific range of days determined by you.

In DacEasy V14 you can filter your aging report by Days Past Due for each invoice. You
can enter a range of past due days and only invoices that have past due days in that range
print.

Tip You can use this feature when you want to analyze the overall performance of
customers with excessive past due days in their invoices.

1. Select Receivables from the Reports menu, and then select Aging. The
Receivable Aging Report dialog box appears.
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Figure 3-15: Accounts Receivable Aging Report

2. Edit the default report criteria, if necessary. If you want to filter the report by
Days Past Due, select the Filter by Days Past Due check box. Enter the range of
days past due in the From Days and To Days fields.

Tip To print the aging schedule for customers with invoices that are between 60
and 90 days past due, enter 60 in the From Days field and 90 in the To Days field.

3. Select OK to access the Report Layout dialog box.

4. Select the target, edit the layout if necessary, and then select OK to print the
report.
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Detail Line Commenting

Avoid errors, improve auditing - enter virtually unlimited number of detail lines
comments or add ample notes for reasoning General Ledger, Accounts Receivable,
Payable, Cash Receipts, and Payment transactions. You enter comments in the detail
grid for each transaction as description type detail lines. Description type detail lines
are entered as free form text in the description column of the grid. Use them to enter
additional information about the detail of the transaction.

Entering Comments on General Ledger
Transactions

1. Select General Ledger from the Transactions menu. The General Ledger
Transaction Entry dialog box appears.

2. Type the journal code or select LookUp and select the journal code.

3. Press Enter in the Number field and the next available transaction number is
assigned.

4. Complete the remaining fields. Select the Reverse check box if you want to
automatically reverse the entry at the close of the accounting period.

5. Enter each account and the amount to debit or credit in the detail portion of
the transaction. You can affect as many accounts as necessary; however, the
total debits and total credits must be equal before you can save the
transaction.

6. Enter C in the Account column and enter your comment in the description
field.

Note You can enter one comment per detail line and as many comment lines
as you need.
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Figure 3-16: General Ledger Transaction Entry Dialog box.

7. Click OK to save the transaction.

Entering Comments on Payables Ledger
Transaction

1. Select Payables Ledger from the Transactions menu. The Payables Ledger
Transaction Entry dialog box appears.

2. Press Enter in the Number field and the next available transaction number is
assigned.
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3. Type a vendor code or select LookUp to select a vendor.

Note You cannot select a Cash-type vendor for payables ledger transactions.
Cash-type vendors can only be selected for Cash module transactions.

4. Complete the remaining fields in the header or select OK to advance to the
detail area of the transaction.

Tip Go to the DacEasy Accounting Users’ guide for more information on
working with the Payables Ledger transactions.

5. Enter each account and the amount to debit or credit in the detail portion of
the transaction. You can affect as many accounts as necessary; however, the
total debits and total credits must be equal before you can save the
transaction.

6. Enter C in the Account column and enter your comment in the description
field.

Note You can enter one comment per detail line and as many comment lines
as you need.

7. Click OK to save the transaction.

Entering Comments on Receivables Ledger
Transaction

1. Select Receivables Ledger from the Transactions menu. The Receivables
Ledger Transaction Entry dialog box appears.
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2. Press Enter in the Number field and the next available transaction number is
assigned.

3. Type a customer code or select LookUp to select a customer.

Note You cannot select a Cash-type customer for receivables ledger
transactions. Cash-type customers can only be selected for Cash module
transactions.

4. Complete the remaining fields in the header or select OK to advance to the
detail area of the transaction.

Tip Go to the DacEasy Accounting Users’ guide for more information on
working with the Receivables Ledger transactions.

5. Enter each account and the amount to debit or credit in the detail portion of
the transaction. You can affect as many accounts as necessary; however, the
total debits and total credits must be equal before you can save the
transaction.

6. Enter C in the Account column and enter your comment in the description
field.

Note You can enter one comment per detail line and as many comment lines
as you need.

7. Click OK to save the transaction.

Entering Comments on Cash Receipt
Transactions

Use the Receipts dialog box to enter receipts you deposited into your bank account.
When you enter a cash receipt, the detail of the transaction depends on the type of
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receipt you enter. You select the type of receipt by entering Customer, Vendor or GL
in the Paid from dropdown box. A list of open invoices appears when you record a
receipt from an open-invoice or balance forward-type customer or vendor, or when
you select Customer or Vendor in the Paid From field. When you select GL in the
Paid From field, you must enter one or more general ledger accounts in the detail of
the transaction.

With DacEasy V14 you can enter an unlimited number of detail line comments when
the Paid From field is set to GL. Detail line comments do not apply when Customer
or Vendor is selected in the Paid From field.

1. Select Cash Entry from the Transactions menu, and then select Receipts.
The Receipts dialog box appears.

2. Press Enter in the Number field and the next available transaction number is
assigned.

3. Complete each field in the header area of the transaction. The account
entered in the Banking field on the Account Interface dialog box appears in
the Bank field; however, you can type a different account number or select
LookUp from the field and select a different account. Select GL in the Paid
From field.

Tip When GL is selected in the Paid From field, you can select a cash type
customer or vendor in the Code field to reference the source of the receipt;
however, the receipt does not affect the customer or vendor account.

4. Complete the remaining fields in the header or select OK to advance to the
detail area of the transaction.

Tip Go to the DacEasy Accounting Users’ guide for more information on
Entering Cash Receipts.

5. Enter each account and the amount to credit in the detail portion of the
transaction.
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6. Enter C in the Account column and enter your comment in the description
field.

Note You can enter one comment per detail line and as many comment lines
as you need.

Entering Comments on Cash Payment
Transactions

Use the Payments dialog box to enter payments made from your bank account. When
you enter a cash payment, the detail of the transaction depends on the type of payment
you enter. You select the type of payment by entering Customer, Vendor or GL in
the Paid to dropdown box. A list of open invoices appears when you record a
payment from an open-invoice or balance forward-type customer or vendor, or when
you select Customer or Vendor in the Paid To field. When you select GL in the Paid
To field, you must enter one or more general ledger accounts in the detail of the
transaction.

With DacEasy V14 you can enter an unlimited number of detail line comments when
the Paid To field is set to GL. Detail line comments do not apply when Customer or
Vendor is selected in the Paid To field.

Note Select the Print Comments on Check Stub check box in Edit Forms Setup if
you want detail line comments to print on the check stub. Leave the check box un-
selected if you do not want detail line comments to print on the check stub.

1. Select Cash Entry from the Transactions menu, and then select Payments.
The Payments dialog box appears.

2. Press Enter in the Number field and the next available transaction number is
assigned.

3. Complete each field in the header area of the transaction. The account
entered in the Banking field on the Account Interface dialog box appears in
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the Bank field; however, you can type a different account number or select
LookUp from the field and select a different account. Select GL in the Paid
To field.

Tip When GL is selected in the Paid To field, you can select a cash type
customer or vendor in the Code field to reference the payee; however, the
payment does not affect the customer or vendor account.

4. Complete the remaining fields in the header or select OK to advance to the
detail area of the transaction.

Tip Go to the DacEasy Accounting Users’ guide for more information on
Entering Cash Payments.

5. Enter each account and the amount to credit in the detail portion of the
transaction.

6. Enter C in the Account column and enter your comment in the description
field.

Note You can enter one comment per detail line and as many comment lines
as you need.

7. Click OK to save the transaction.
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Attach Notes to Transactions

Improve auditing with ample amount of space to capture important information for
easy reference when reasoning a General Ledger, Accounts Receivable, Accounts
Payable, and Cash transactions.  Using the DacEasy notes editor you can type free
form text with information pertaining to the transaction being entered. This
information is associated to the transaction and it can be printed in the Transaction
Journal.

To Add Notes to Transactions

1. Select the transaction entry option you want from the Transactions menu.
You can enter notes for General Ledger, Payables Ledger, Receivables
Ledger, Cash Receipts, and Cash Payment transactions.

Note For more information on entering transactions refer to the DacEasy
Accounting User’s guide.

2. Select an existing transaction from the LookUp or press enter in the
Transaction Number field to create a new transaction.

3. Click Options, and then click Edit Note to display the Note Editor.

4. Type the note.

Tip You can click Date Stamp to insert the current program date or Time
Stamp to insert the current time.

5. Click Print if you want a printed copy of the note.

Tip Click Help from the Note Editor for additional assistance on editing the
note.
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6. Click OK to save the note.

Note DacEasy uses the Journal Code plus the transaction number and the .ext
extension for the note name. All notes are stored in the NOTES folder
created inside the company data folder.

To Print Transaction Notes

1. Select the Journal option you want from the Journals menu. You can print
notes for General Ledger, Payables Ledger, Receivables Ledger, Cash
Receipts, and Cash Payment journals.

Note For more information on printing journals refer to the DacEasy
Accounting User’s guide.

2. Select the Print Transaction Notes check box if you want the notes to show
on the journal or listing report. Leave this field un-checked if you do not
want notes to show on the report.
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Figure 3-17: Payables Journal dialog box.

3. Select OK to access the Report Layout dialog box.

4. Select the target, edit the layout if necessary, and then select OK to print the
report.

Quotes

This feature provides you with the ability to create, save, and print sales quotes for
prospective or existing customers. Plus upon realizing a sale, customers can convert the
stored quote to an invoice which will save you time from re-entering the information.
Quotes are simply a means for you to provide a printed copy of your prices, without
entering an invoice.

DacEasy V14 uses a template to print quotes. You can customize this template to meet
your needs. A default template, QUOTES.FMT, is setup when you install version 14.
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To Enter a Quote

1. Select Sales Quotes from the Transactions, Billing Entry menu. The Sales
Quotes dialog box appears.

Figure 3-18: Sales Quotes dialog box.

2. Press Enter in the Quote Number field and the next available quote number is
assigned. To edit an existing quote, click on LookUp and select one from the list.

3. Complete each field in the quote header and click OK to move to the detail
section of the quote.

Tip Enter the correct information on each of the header fields if you have it.
Quotes are converted to invoices using this information.
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4. Complete the fields in the detail of the quote as if entering an invoice. Refer to
“Entering Invoices” in the Accounting User’s guide for more information.

5. Click on Print Quote to print the quote and the Report Layout appears.

Note The Print Quote option appears on the toolbar when you move to the detail
section of the quotes dialog box.

6. Edit the layout if necessary, and click OK to print.

7. Click OK to save the quote.

Editing the Quotes Template

1. Select Defaults from the Edit menu and then select Forms Setup. The Edit
Forms Setup dialog appears.

2. Select Sales Quotes from the Form dropdown box.



96           DacEasy Installation & New Features Guide

Chapter 3   DacEasy V14 Features

Figure 3-19: Select Sales Quotes in the Edit Forms Setup dialog box.

3. Click on Names and the Format File Names dialog appears. Enter the name of
your check template in the Quotes field. Click on LookUp to select from a list of
available templates.

4. To create a new template type the template name in the Quotes field. To select an
existing template, type the template name or click on LookUp and select the
template.

Tip Select Options and select Copy Format to make a copy of an existing
template.

5. Click on OK to save the Format File Names and return to the Edit Forms Setup
dialog.

6. Click on Edit to work on your quote template. Click OK when you finish
designing or editing your template.

7. Click OK to save your quote form settings.



DacEasy Installation & New Features Guide          97

D
acEasy V14 Features

DacEasy V14 Features   Chapter 3

Note Refer to the “Editing templates” and “Template Variables” topic in Help for
more information on how to create or edit form templates.

Transaction Voucher Document

Maintain more control over General Ledger, Accounts Receivable, and Accounts Payable
transactions. If your company requires approval or signatures for certain transactions, this
feature allows you to print a document for approval to keep for auditing purposes.

Printing a Transaction Voucher Document is an optional feature in DacEasy Accounting
V14. You can activate printing of transaction vouchers for each ledger separately by
accessing the settings for that ledger in System Preferences.

To Activate Transaction Voucher Documents

1. Select Defaults from the Edit menu, and then select System Preferences. The
Edit System Preferences dialog box appears.

2. Click on the Ledgers tab and select General from the Ledger dropdown box.
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Figure 3-20: System Preferences dialog box – Ledgers options.

3. Select the Print Voucher check box to print a voucher document when you save
a General Ledger Transaction.

4. Select Pause before Printing if you want DacEasy to prompt you before printing
the voucher document.

Tip Select this option if you do not want to print a voucher document for all the
transaction you enter. With this option selected, DacEasy asks you for
confirmation before printing each document.

5. Select the One Trans. Per Page if you want each Voucher Document to print on
a new page. DacEasy sends a form feed after printing each transaction.

Tip Select this option if you want to want to create a paper file for each
transaction you enter into your ledgers.
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6. Select Receivables from the Ledger dropdown box.

7. Select the Print Voucher check box to print a voucher document when you save
a Receivables Ledger Transaction.

8. Select Pause before Printing if you want DacEasy to prompt you before printing
the voucher document.

9. Select Payables from the Ledger dropdown box.

10. Select the Print Voucher check box to print a voucher document when you save
a Payables Ledger Transaction.

11. Select Pause before Printing if you want DacEasy to prompt you before printing
the voucher document.

To Print Transaction Voucher Documents

Voucher Documents print automatically when you activate the option for the Ledger in
which you are entering transactions. If you selected the Pause to Print Voucher check
box in system preferences, DacEasy will prompt you before printing each voucher.

Figure 3-21: Confirmation of Voucher Document Printing.

1. Answer Yes and the Report Layout dialog appears.

2. Edit the layout, if necessary, and Click OK to print the document.
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Figure 3-22: Transaction Voucher Document

Print OCR Ready Checks

This feature provides you the option to select whether you want to use an OCR Ready check
format or a standard format. You may be able to save your company money by using OCR
check formats because some banks offer discounts to customers when processing with this
check format. This format which is available in the Payroll module is now available in your
Accounting module.

To make OCR Ready the check printing option for all bank accounts, setup OCR Checks as
the check type in Edit Forms Setup. You can OCR Checks as the check type for specific
bank accounts. To do this, use the Check Form option in Edit Accounts.
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To Print OCR Checks

1. Select Defaults from the Edit menu and then select Forms Setup. The Edit
Forms Setup dialog appears.

2. Select Checks from the Form dropdown box.

3. Click on the Check Type dropdown box and select OCR Checks as your check
printing option.

Figure 3-23: Edit Forms Setup dialog box

4. Select the Print Comments on Check Stub check box if you want detail line
comments on your payment transaction to print on the check stub.

Note For more information on detail line comments go to the Detail Line
Commenting section of the Installation and New Features Guide. You can
change these options at anytime.

5. Click OK to save your check form settings.
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To setup OCR Checks for a specific bank
account

1. Select Accounts from the Edit menu and the Edit Accounts dialog appears.

2. Click on LookUp to select the bank account to edit.

3.  Click on Options and then select Check Forms. The Edit Check Options
dialog appears.

3-24: Edit Check Options Dialog

4. Select OCR Checks as the printing option in the Check Type dropdown box.

6. Select the Print Comments on Check Stub if you want detail line comments on
your payment transaction to print on the check stub.

Note For more information on detail line comments go to the Detail Line
Commenting section of the Installation and New Features Guide.
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5. Click OK to save the check printing settings.

Format Financial Statements
DacEasy V14 improves the presentation of the General Ledger Financial Reports by
giving you the option to use standard currency format for number columns in the Trial
Balance, Income Statement, and Balance Sheet Reports. The Statement of Cash Flows
prints with formatted numbers by default. You may also customize the title of the report.

Modifying the Trial Balance Report

1. Select General Ledger from the Reports menu, and then select Trial Balance.
The Trial Balance dialog box appears.

Figure 3-24: Trial Balance Report Dialog
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2. Select Format in the Amount Format dropdown box if you want numbers to be
formatted with commas. Select Normal in the Amount Format dropdown box to
print amounts without commas.

Figure 3-25: Trial balance Report with Format option.

3. Modify the report title in the Report Title field, if necessary.

4. Click OK and the Report Layout dialog appears.

5. Select the target disposition, modify the layout if necessary, and click OK to view
the report.

Note Select Income Statements or Balance Sheet from the Reports menu and
follow the same steps to modify format those reports.
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Payroll

Payroll Processing with Groups
More flexible payroll processing! Now you may classify your payroll runs into groups
defined by you. For example, you may want to run payroll for a group of employees that
contain both hourly and salaried employees. Payroll Groups consist of one or more
salaried or hourly employees that are processed in the same payroll run. Use Payroll
Groups when you want to have payroll processing cycles segregated by groups of
employees with similar characteristics.

To Create Payroll Groups

1. Select Payroll Groups from the Edit menu. The Edit Payroll Groups dialog box
appears.
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Figure 3-26: Edit Payroll Groups dialog box.

2. To create a new group, enter a unique identifier in the Group Code field. i.e.,
HOUR_SHFT1, SAL_EXEC1, etc.

3. Enter a descriptive description in the Description field.

4. Click OK to save the payroll group.

To Assign Payroll Groups to Employees

1. Select Employee Information from the Edit menu. The Edit Employee
Information dialog box appears.

2. Click on LookUp to select the employee you want to assign the payroll group to.

3. Select the Dates and Pay tab to move to that section of the dialog box.

4. Enter the payroll group code in the Pay Group field. Click on LookUp to select
from existing payroll groups.

5. Click OK to save the employee.
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Figure 3-27: Edit Employee Information – Dates and Pay Tab.

6. Click OK to save the employee information.

To Process Payroll Groups

1. Select Calculate Payroll from the Process menu. The Pay Frequency dialog
box appears.

2. Fill in the pay frequency information and click OK to continue. The Automatic
Payroll Calculation dialog box appears.

3. Select the Payroll Group you want to process from the Include Pay Type
dropdown box.
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Note The Include Pay Type dropdown box includes Salaried, Hourly, All, and all
the payroll group codes from the Payroll Groups table.

4. Fill in the rest of the information in the Automatic Payroll Calculation dialog box.

5. Click OK to process your payroll.

Note For more information on Calculate Payroll refer to the Payroll User’s
Guide.

To Print Payroll Checks for Payroll Groups

1. Select Checks from the Process menu. The Print Checks dialog box appears.

2. Select the Payroll Group you want to process from the Employee Type
dropdown box.

Note The employee type dropdown box includes Salaried, Hourly, All, and all the
payroll group codes from the Payroll Groups table.

3. Fill in the rest of the information in the Print Checks dialog box.

4. Click OK to print your checks.

Note For more information on printing checks refer to the Payroll User’s Guide.
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Point of Sale

Print Receipts through Windows Printer Drivers
DacEasy Point of Sale V14 extends receipt printing options to use Microsoft Windows
Printer drivers. Printing through the system’s printer drivers allows you to connect to any
printer supported by Windows, including laser and ink jet printers. Older versions of
DacEasy Point of Sale print sales receipts directly through the printer ports attached to
your systems. This option is still available in V14 to accommodate older receipt printers.
If you choose this option, you need to setup your receipt printers in Edit Receipt
Printers.

If you selecting to print through the Windows drivers, DacEasy prints through the printer
drivers setup in your computer or network. These are the same drivers used to print other
reports in DacEasy. You can redirect receipts to multiple printers by selecting the target
printer from the Report Layout dialog box. DacEasy remembers the last option selected on
each station and presents it as default the next time you print.

To Setup the Receipt Printing Option

1. Select Defaults from the Edit menu, and then select System Preferences. The
System Preferences dialog box appears.

2. Select Windows drivers in the Receipt Printing Engine dropdown box.
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Figure 3-28: Point of Sales System Preferences Dialog

3. Click OK to save your system preferences.
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Working With DacEasy

Now that you have set up your company profile and passport, you are ready to start using
the program. Use this chapter to familiarize yourself with the features common to all
DacEasy programs. This includes information on viewing your data, creating presentation
quality reports, using the Date Selector button, Calculator, AutoComplete and LookUps,
sending e-mails, and working with toolbars.

Note  Refer to each program’s User’s Guide for information on features specific to the
module.

Viewing Your Data
When you choose to print information in DacEasy, you can view the output on the screen,
send it to your printer or export the information. You can also publish the data directly to
HTML and to Microsoft Excel. The Report Layout dialog box appears each time you
choose to print information in DacEasy and allows you to select your output target and
customize the report layout.

The default report layout is based on the printer information supplied on the Edit Default
Printer dialog box. You can customize each section of a report, which includes font
attributes such as font type (including variable pitch fonts), color, size and style. You can
also customize the page layout information.



112            DacEasy Instal lat ion & New Features Guide

Chapter 4   Working With DacEasy

If you customize the report layout for the current report, these settings are saved and are
used the next time you print the report. You can select different printer preferences for each
report in DacEasy.

Note  The Plain Paper check box that appears on the Report Layout dialog box is only
available in DacEasy Payroll. This feature is available when printing certain payroll forms
on plain paper and requires Adobe Reader. For more information on the Plain Paper features,
refer to the DacEasy Payroll Help system.

Figure 4-1: Use the Report Layout dialog box to select the output format for the information.
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Using the Report Viewer
If you select screen as your target, the information appears in an easy-to-view format on
your screen using the Report Viewer. You can copy information in the Report Viewer to the
Clipboard, and then paste the information into a different application if you choose. To copy
information in the Report Viewer to your Clipboard, select the text with your mouse, right-
click, and then select Copy.

To view the output as it appears on paper, click Preview. From the Preview, you can scroll
up and down the pages, and zoom in and out for more or less detail. After you have viewed
the information, you can send the report to the printer or exit the view.

Note  When viewing information in the Report Viewer, the toolbar is in a fixed position and
cannot be moved.

Exporting Information From DacEasy
You can export information from the Report Layout dialog box using the Export or Publish
option. The Export option allows you to export the information to a text, delimited ASCII,
Excel 5 or HTML file. The Publish option allows you to publish your information with the
current formatting to HTML or Microsoft Excel 97, 2000 or XP. To automatically view your
information in a Web browser or Excel worksheet, select Publish as the target, the Publish
tab appears. Select the type, and then select the Launch Application check box.

The Export option is available for all reports. The Publish option is available for all reports;
however, publishing to Excel is only available for certain reports. If a report does not
already exist with the information you want to export, create a query in DacAccess and
export the information from the query. Refer to your User’s Guide for more information on
creating a query in DacAccess.

Note  You cannot export forms that use templates. This includes billing, purchasing, order
and sales receipt forms as well as labels.
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To View Data
1. View the Report Layout dialog box by clicking Print or OK from a report

or form dialog box.

2. Select the target. The following options are available:

Note  Refer to the “Changing the Report Layout” section for more
information.

Screen—Select this option to view the information on the screen. Edit the
report layout if necessary.

Note  You can redirect the information from the screen to the printer if
needed.

Printer—Select this option to print the information on paper. Edit the
report layout if necessary.

Tip  A Test Page option is included when printing forms. To check the
form alignment, click Test Page and a test page prints based on your
report layout settings, with “X’s” in place of your data. If the form does
not print properly, adjust your report layout or form placement, and then
print another test page.

Note  The Plain Paper check box that appears on the Report Layout
dialog box is only available in DacEasy Payroll. This feature is available
when printing certain payroll forms on plain paper and requires Adobe
Reader. For more information on the Plain Paper feature, refer to the
DacEasy Payroll Help system.

Export—Select this option to export the information to a text, delimited
ASCII, Excel 5 or HTML file. Type the path and file name where you
want to create the file, and then select the File Format. If you selected
Export, select the Export type. If you selected ASCII as the Export type,
enter the Text and Field Delimiters.

Publish—Select this option to publish the file in a format that can be read
by a third party application. You can publish all reports to HTML, the file
format that can be used by Web browsers. You can publish many reports
to Excel. Type the path and file name where you want to create the file,
select whether or not you want to automatically launch the application to
view the data, and then edit the Fonts tab if necessary.

3. Click OK to view the report or create the export file.



W
orking W

ith

Working With DacEasy   Chapter 4

DacEasy Instal lat ion & New Features Guide          115

Changing the Report Layout
DacEasy allows you to easily create customized presentation quality reports. Each report
initially uses the report settings on the Edit Default Printer dialog box; however, you can
customize each individual report as needed. These customized settings are saved for each
report so you can select a different layout for each report.

Note  Refer to Chapter 4, “Setting Up,” in the User’s Guide for information on setting up
your default printer.

To Change the Report Layout
1. Access the Report Layout dialog box.

2. Select the printer in the Name box on the Printer tab.

Tip  Click Restore Default to restore the default printer settings, which
are set on the Edit Default Printer dialog box.

3. Click the Fonts tab. Use this tab to select your font preferences for each
section of the report. Select a section, and then select your preferences for
the section.

Repeat this process for each section of the report.

4. Click the Page tab. Select your preferences for the page setup.

Note  The Width and Height boxes only apply when you select a custom
paper size.

5. Click OK to save your printing preferences and print the report.

Tip  Click Set as Default to update the default printer settings on the Edit
Default Printer dialog box with the current report layout settings.
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Using the Date Selector Button
A built-in calendar is available in the program when selecting a date. A Date Selector button
appears next to all editable date fields. Click the Date Selector button next to a date field
and a pop-up calendar appears. For more information on changing the date, refer to the
section titled “Changing the Date” in Chapter 5, “Working With the Business Center.”

Figure 4-2: Use the Calendar to select a date for the current field.

Selecting a Date
To select a specific date while viewing the calendar, click the date you want and the selected
date appears in the current field. You can also use the Up arrow, Down arrow, Left arrow
and Right arrow to change the selected date and press Enter to paste the date in the current
field.

Changing the Month
To change the month you are viewing, click the right arrow or left arrow to change the next
month forwards or backwards. Click the name of the month and a list of months appears.
Select the month you want from the list. You can also press the Page Up or Page Down
button to change the month forwards or backwards.

Changing the Year
To change the year you are viewing, click the year. The Year box appears. Click the
appropriate arrow to change the year accordingly. You can also use the Up arrow and Down
arrow keys to change the year while viewing the Year box.
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Using the Calculator
A built-in calculator is available in the program. View the Calculator by clicking Options,
and then choosing Calculator. The calculator performs basic mathematical functions such
as addition, subtraction, division and multiplication. Furthermore, you can paste a value
from the calculator into any numeric field in DacEasy by pressing P.

Figure 4-3: Use the Calculator to perform mathematical equations and paste the result into a numeric
field.

The calculator works just like a hand-held calculator. Press the number or first letter of the
key you want to use. If you are using a mouse, click the left mouse button to activate keys
on the calculator. The following table lists the keys available on the calculator, along with
their functions:

Access key Button Calculator functions

S Sqr Displays the square root of a value.

E Exp Allows you to use exponential notation. After pressing E, the
next value you type raises a number to that power. For
example, the key combination 2E3= displays the number 23,
which is 8.

M Mem Stores the current value into memory. You can recall this value
later by pressing M again.

C Clr Clears the current value and resets all arithmetic operations.

P Paste Pastes a value into the current field. After pressing P, the
calculator closes and the cursor returns to the active field. You
can only paste values from the calculator into numeric fields.

B Back Clears the last digit entered.

F Fmt Toggles the displayed value between floating and fixed
notation.
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Using the LookUp
LookUp is the term DacEasy uses to describe a list of records that are available from a field.
When a LookUp is available from a field, the LookUp button is available. If a LookUp is
not available for the active field, the button does not appear on the toolbar or appears
dimmed. Click the LookUp button to view the list of available records. Select a record to
paste it in the current field or click Close to exit the LookUp without selecting a record.

 

Figure 4-4: Use the LookUp to select a record for the current field.

When you initially view a LookUp, the selection bar highlights the first record in the file.
When you return to a LookUp during the same DacEasy session, the selection bar remains
positioned on the record previously selected. This feature can be very handy if you need to
access records in a file sequentially. When you exit and reenter DacEasy, the selection bar
returns to the top of every LookUp. When you close and reopen a screen through the
Business Center, the selection bar returns to the top of each LookUp on the screen.

Selecting the Sort Columns
Most LookUps allow you to sort on any column and add an optional secondary sort. To sort
the LookUp on a single column, click the column header. To add a secondary sort, hold
down the Ctrl key and click the column header you want as the secondary sort.
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An arrow appears to the right of the column header to indicate that the LookUp is sorted by
the information in the column. If the LookUp has a secondary sort, a 1 appears to the right
of the arrow in the primary sort column header and a 2 appears to the right of the arrow in
the secondary sort column header.

Selecting the Sort Order
You can view the information in the sort columns in ascending or descending order. The sort
defaults to ascending. An up arrow to the right of the column header indicates the column is
in ascending order. A down arrow to the right of the column header indicates the column is
in descending order.

If the LookUp is sorted on a single column, click the column header to switch the sorting
order. If the LookUp has a secondary sort, hold down the Ctrl key and click either sort
column to switch the sort order.

Note  The primary and secondary sorts always have the same sort order.

Resizing Columns
You can change the width of each column in a LookUp. To change the column width, place
the mouse on the right border of the column header. When the pointer changes to a 
(double-headed arrow), click the mouse and drag the edge of the box to change its width.

Locating a Record
You can locate a record with the mouse, arrow keys or the Search feature.

Using the Mouse
A vertical scroll bar appears when all rows in the LookUp are not visible. A horizontal scroll
bar appears when all columns in the LookUp are not visible.

Click above the scroll box on the vertical scroll bar to page up. Click below the scroll box
on the vertical scroll bar to page down. Click the arrows on the vertical scroll bar to move
up or down one record at a time. Click the scroll box and drag it up or down to quickly
access a different area in the LookUp.

Click the horizontal scroll bar to view the column relative to your position on the scroll bar.
Click the arrows on the horizontal scroll bar to move one character at a time.

To select a record with the mouse, double-click the record.
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Using the Keyboard
Press the Up Arrow and Down Arrow keys to move through the LookUp one record at a
time. Press the Page Up and Page Down keys to page through the LookUp. Press
Ctrl+Home to locate the first record. Press Ctrl+End to locate the last record.

To select a record with the keyboard, press Enter.

Using the Search Feature
The Search feature allows you to quickly locate a record within the primary sort. You can
type the record you want to view and the LookUp scrolls to the closest match when you
press Enter. For example, if your customer codes are based on the customer’s name and you
have a customer named Jim Smythe, but are unsure of the spelling, click LookUp from the
Customer Code field to view the LookUp. Type J and the selection bar moves to the first
code beginning with J. Locate the desired record, and then select it.

DacEasy incorporates smart searches in all entry fields allowing a LookUp. To perform a
smart search, type any text in the entry field. After entering the text, click LookUp to view a
list of available records. DacEasy automatically selects the record that most closely matches
the text you entered.

For example, assume your customer codes always begin with the first letter of the
customer’s last name and you need to locate Edwin Simmon’s customer record. Type S in
the Customer Code field, and then click LookUp. The Customer LookUp appears with the
first customer code beginning with the letter S selected. Now, you can scroll to the
appropriate record.

Adding and Editing Records From a LookUp
DacEasy gives you the ability to add and edit records “on-the-fly” from certain LookUps.
When this feature is available, an Add button and Edit button appear on the toolbar. If you
discover a record does not exist, click Add to add the record to the list. To edit a particular
record in a LookUp, select the record and click Edit.
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Using AutoComplete
Use the AutoComplete feature to quickly enter information into DacEasy. This feature
remembers information you have previously entered into a field or quickly pulls information
from your LookUps. As you type characters into a field, DacEasy matches the information
to entries stored in your LookUps or information you have previously entered. A list of
suggestions appears based on these matches. You can select one of the suggested choices or
continue to type additional characters to narrow the list of suggestions. If a single possible
match is found, the value can be inserted in the current field if you selected this option when
setting the AutoComplete preferences. The value you typed appears normal and the
information inserted by the AutoComplete feature appears highlighted. For more
information on setting the AutoComplete preferences, refer to Chapter 5, “Working With the
Business Center.”

Figure 4-5: The AutoComplete list matches the information you are typing with information in your
LookUp lists or information you have previously entered into the current field and offers a list of
suggested choices.
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Sending an E-mail
Use the Instant Correspondence feature to keep in close communication with your
customers, vendors and employees. Each customer, vendor, salesperson, warehouse and
employee record has an E-mail field. Click the E-mail button attached to the field to launch
your e-mail program. A new e-mail message appears with the To box completed with the
recipient’s e-mail address. For more information on sending a batch of e-mails using the
Mail Merge feature, refer to the User’s Guide for each module.

Note  This feature is also available when using the Business Alerts feature. While setting
your alert rules, you can compose an e-mail message to send to select recipients when the
alert is detected. For more information on the Business Alerts feature, refer to Chapter 6,
“Working With Business Center Pages.”

Note  You must have a simple MAPI compliant e-mail system to use the Instant
Correspondence feature to send an e-mail.

Figure 4-6: Use the E-mail button to send an e-mail to a customer, vendor, salesperson, warehouse or
employee.
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Using the Toolbars
DacEasy has three types of toolbars: (1) the main DacEasy application toolbar, (2) the
DacEasy Modules toolbar and (3) the toolbar that appears when you access a dialog box in a
DacEasy module. Point to a button on any toolbar to view a ToolTip. The ToolTip includes
the button label if it is not included on the button and the shortcut key when applicable. You
can click the button to carry out the action, or press the shortcut key if available.

If you are using the Business Center, refer to the section titled “Modifying the Business
Center Appearance” for more information on customizing the Modules toolbar that appears
in the Business Center.

If you are not using the Business Center, the default main application toolbar in each
DacEasy module includes the most commonly used features. You can customize the toolbar
per station ID, which allows you to customize the program to meet your specific needs. For
information on customizing the toolbar in the individual DacEasy modules, refer to the
individual program’s Help topic titled “Customizing the toolbar.”

Each DacEasy module dialog box has a toolbar with the commands that apply to the current
dialog box. Some toolbars include an Options button that displays a menu when clicked.
Select a command from the menu or press the shortcut key associated with the menu
command. If an option is not available from the current field, the button appears dimmed.
You cannot customize the commands that appear on a toolbar associated with a dialog box.

Setting Button Label Preferences
You can display the main application toolbar in each DacEasy module or the Business
Center Modules toolbar with or without button labels. To change the current status in the
DacEasy modules, right-click on the toolbar (not on a button), and then select Hide Label
to display the buttons without descriptive text labels or Show Label to display the buttons
with descriptive text labels. You can also select the label preferences on dialog box toolbars.

To change the current status in the DacEasy Business Center, right-click on the toolbar, and
then select Customize. The Appearance dialog box appears with the Toolbars tab
available. Select the appropriate label setting and then click OK.

Note  Button labels always appear for toolbar buttons without an image. For more
information on the Show Labels setting in the Business Center, refer to the Help topic titled
“Customizing the toolbar” in the Business Center Help.

The button label appears below the image on the main DacEasy application toolbars in the
modules and to the right of the image on the DacEasy Modules toolbar in the Business
Center and the dialog box toolbars.
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Positioning Toolbars
You can float, dock or hide most DacEasy dialog box toolbars and the main application
toolbar except the Business Center Modules toolbar and the Explorer bar.

A docked toolbar does not move. If you are not running the DacEasy modules through the
DacEasy Business Center, the main application toolbar can be docked to any edge of the
DacEasy desktop. The dialog box toolbar can be docked to any edge of the dialog box. You
can also float either of these two toolbars. A floated toolbar can be moved anywhere on the
desktop.

Tip  You can drag and drop the toolbar to any position needed, floated or docked. You can
also resize the toolbar to adjust the orientation.

Note  When viewing information in the Report Viewer, the toolbar is in a fixed position and
cannot be moved.

To float a toolbar—Right-click on the toolbar (not on a button), and then select Float or
double-click the toolbar (not on a button).

To dock a toolbar—Right-click on the toolbar (not on a button), and then select Dock or
double-click the toolbar (not on a button).

To hide a toolbar—To hide a toolbar in the DacEasy modules, right-click on the toolbar
(not on a button), and then click Hide Toolbar. To hide a toolbar in the DacEasy Business
Center, right-click on the Modules toolbar and a list of available toolbars appears. Select the
toolbar you want to hide. The check mark is removed for the selected toolbar indicating it
does not appear in the Business Center. You can also make this selection using the Toolbars
tab on the Appearance dialog box in the Business Center.

To show a hidden toolbar—To show a toolbar in the DacEasy modules, click the system
menu icon located in the top left corner of the dialog box, and then select Show Toolbar. To
show a toolbar in the DacEasy Business Center, right-click on the Modules toolbar and a list
of available toolbars appears. Select the toolbar you want to show. A check mark appears
next to the toolbar indicating it appears in the Business Center. If no toolbars appear in the
Business Center, select Toolbars on the Windows menu and select the toolbar you want to
show. You can also make this selection using the Toolbars tab on the Appearance dialog
box in the Business Center.
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Working With the Business
Center

The Business Center provides a single entry point for all DacEasy programs and includes a
number of features designed to increase productivity. This includes the ability to view
multiple windows concurrently, update company information for all DacEasy modules, and
back up or restore data without exiting the Business Center. In addition, you get quick
access to your data, the Internet and other helpful resources.

This chapter provides you with information that is helpful when using the Business Center.
The first section gives a description of each component in the Business Center. The other
sections explain how to work with your company profiles, edit your company information,
use the Business Center tools and manage multiple windows.
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Understanding the Business Center
Use this section to familiarize yourself with the different areas in the Business Center. The
following diagram labels each area in the Business Center. A description of each area
follows.

Figure 5-1: Use this diagram to familiarize yourself with the Business Center.
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Business Center Title Bar
The title bar is located at the top of the Business Center window. It includes the system
menu icon and name of the program on the left side and four buttons on the right side. A
brief description of each button follows.

The first button is the Workspace button. Use this button to hide or show the
Business Center workspace. If the workspace is visible, click this button to
hide the workspace. If the workspace is hidden, click this button to show the
workspace.

The next button is the Minimize button. Click this button to reduce the
program to a button on the taskbar.

This is the Maximize button. If this is the next button to appear on the title
bar, you are currently viewing the Business Center in Restored view. Click this
button to expand the view of the Business Center to cover your entire desktop
area.

This is the Restore button. If this is the next button to appear on the title bar,
you are currently viewing the Business Center Maximized (over your entire
desktop area). Click this button to restore the view to its previous size.

This is the Close button. Click the Close button to exit the program.

Business Center Menu Bar
The Business Center menu bar is located below the title bar by default. This menu bar can
be moved to fit your preference. It includes the menus relevant to the Business Center.

The Profile menu includes commands applicable to company profiles. You can add profiles,
open profiles or edit profiles. In addition, you can choose Exit from the Profile menu to
close all profiles and exit the Business Center.

The Tools menu includes commands to backup and restore company data, change the date,
set alert rules, schedule tasks and set workspace preferences and appearance.

The Windows menu lists all DacEasy windows that are currently open. Select a window in
the menu to make the window active. This menu also allows you to view or hide the
Business Center workspace, Modules menu bar and Modules toolbars.

The Help menu includes access to the Help files and the About DacEasy Business Center
information.
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DacEasy Modules Menu Bar
The DacEasy Modules menu bar is located next to the Business Center menu bar by default.
It can be moved to fit your preference. Use the DacEasy Modules menu bar to access the
menu commands available in the individual DacEasy programs. For more information on
changing the DacEasy Modules menu bar, refer to the section titled “Modifying the
Business Center Appearance.”

Note  If you try to access a menu command from the DacEasy Modules menu bar for a
module that is not in the current company profile, an error appears.

DacEasy Modules Toolbar
The standard DacEasy Modules toolbar is located below the Business Center and Modules
menu bar by default. It can be moved to fit your preference. The standard Modules toolbar
is created based on your scheme selection. You can create additional Modules toolbars to fit
your needs. For more information on adding and changing the DacEasy Modules toolbars,
refer to the section titled “Modifying the Business Center Appearance.”

Explorer Bar
The DacEasy Business Center includes a browser, Internet Explorer, that allows you to view
HTML pages. This includes HTML pages accessed via the Internet and HTML pages
specific to the Business Center that are located on your computer. Use the Explorer bar to
select the page to view or refresh the page. For more information on each button that
appears on the Explorer bar, refer to the section titled “Using the Explorer Bar” later in this
chapter.

Business Center Workspace
The Business Center workspace is the area where you view Business Center and HTML
pages. The Business Center pages typically consist of three distinct areas, the Navigation
bar, the Contents bar and the Contents area. The Navigation bar includes links to different
features available in the Business Center workspace. The Contents bar includes links to
different pages related to the current page. The Contents area is where the page appears.

Note  To hide or show the Business Center workspace, click the Workspace button located
on the title bar or select Workspace on the Windows menu.

Business Center Status Bar
The status bar shows the name of the current company profile. This can be especially useful
if you access data in multiple company profiles.
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Working With Profiles
If you want to use the Business Center, you must add a company profile for each company
you track in DacEasy. Use the commands on the Profile menu to add new company profiles
and open existing profiles. In addition, you can edit the profile by adding and removing
modules, editing the password information, editing the company information and editing
users. There is also an Exit command that closes all profiles and closes the Business Center.

For more information on adding profiles, opening profiles or editing passwords, refer to
Chapter 1, “Installing DacEasy.”

Adding Modules to a Company Profile
When you add your company profile, you have the option to add a single module or
multiple modules. You can always use the Add Module wizard to add additional modules
after setting up the company profile.

To Add a Module to a Company Profile
1. Select Edit from the Profile menu, and then select Add Module. The Add

Module Wizard appears.

Figure 5-2: Use the Add Module wizard to link data files from other DacEasy
modules to the company profile.
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2. Follow the instructions on the screen to complete the wizard. Use the
Back and Next buttons to navigate through the wizard. Click Finish when
you have completed the wizard. A Complete screen appears when the
process is done.

Tip  You can browse for an existing folder when you add a module to a
company profile. Click Browse, and then click Existing companies to
locate existing DacEasy company folders or click Windows folders to
search all folders.

3. Click OK to return to the Business Center.

Removing Modules From a Company Profile
You can use the Remove Module wizard to remove modules from a company profile at any
time. If the company profile consists of multiple modules, you cannot remove Accounting
until all other modules have been removed.

To Remove a Module From a Company Profile
1. Select Edit from the Profile menu, and then select Remove Module. The

Remove Module Wizard appears.

Figure 5-3: Use the Remove Module wizard to remove modules from the company
profile.
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2. Select the modules to remove, and then click Next. A Summary screen
appears.

3. Click Finish to remove each module listed. A Complete screen appears
when the process is complete.

4. Click OK to return to the Business Center.

Removing Company Profiles
You can track information for multiple companies in the Business Center. Use the following
steps if you need to remove a company profile.

Tip  When removing a company profile from the Business Center, DacEasy only removes
the link between the program and the data files. You have to manually delete the data files
for each module from your hard disk drive.

Note  You must have at least one company profile to operate the Business Center. DacEasy
does not allow you to remove the last company profile.

To Remove a Company Profile
1. Select Open from the Profile menu. The Open Company Profile dialog

box appears.

2. Select the profile you want to delete.

3. Click Remove to remove the company profile.

Note  If the Remove button is unavailable, you are attempting to remove
the open profile. Open a different profile. If only one company profile
appears in the list, you cannot remove the profile.

4. Select a company profile from the list and click Open.



132            DacEasy Instal lat ion & New Features Guide

Chapter 5   Working With the Business Center

Editing Company Information
You can enter your company address, phone and tax ID information when you set up a new
profile. You can also update the module data files with this information. Use the Edit
Company Information dialog box to edit the company information for the company
profile. Use the Update Modules option on the dialog box to update the company
information in all the modules at once.

To Edit Company Information
1. Select Edit from the Profile menu, and then select Company

Information. The Edit Company Information dialog box appears.

Figure 5-4: Use the Edit Company Information dialog box to update the company
address information for your company profile. Select the Update Modules check
box to also update the company address information for all modules in the profile.

2. Edit each field as necessary.

3. Select the Update Modules check box if you want to update each module
included in the company profile with your changes.

Tip  Click the Paths tab to view each module included in the profile.

4. Click Save to save your changes.
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Modifying User Information
Use the Company Profile User List dialog box to add additional information for your users.
The Controller is the only user that has access to this dialog box. For more information on
setting the controller password, refer to the section titled “Setting the Controller Password”
in Chapter 1, “Installing DacEasy.” From this dialog box, you can view users, remove users,
update a user’s full name and add comments.

To Modify User Information
1. Select Edit from the Profile menu, and then select Users. The Company

Profile User List dialog box appears.

Note  If the controller password has been saved, a password prompt
appears. Type the controller password and click OK to continue.

Figure 5-5: Edit User information and set the controller password from the
Company Profile User List dialog box.

2. Select the user you want to edit from the Users list. Type the full name of
the user, add any comments, and then select a scheme for the user.

3. Click Update to save your changes.

4. Click Cancel to return to the Business Center.
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Using the Business Center Tools
Access the commands on the Tools menu to back up and restore company data files, set
Business Alert rules, schedule tasks, change the program date and set preferences for the
workspace.

Protecting Your Data
One of the most important functions in DacEasy is the Backup function. In the event of a
hard disk drive failure or excessive data corruption, you must restore a backup. Without a
backup, you have to enter all your data again. It is very important that you take the steps
required to have a current backup at all times.

A comprehensive guide to making backup copies of your data follows. These steps require
you to retain 10 sets of backup disks. With these 10 sets, you will have three months of data
in the event you need it. Backup disks are divided into three groups of individual sets: four
individual sets for daily backups (labeled Day 1, Day 2, Day 3 and Day 4), three individual
sets for weekly backups (labeled Week 1, Week 2, Week 3), and three individual sets for
monthly backups (labeled Month 1, Month 2, Month 3).

To Store a Complete Data Library
1. Perform a full backup of all your DacEasy data files onto the Week 1 set

of backup disks. We recommend you perform this operation on a Friday
night.

2. Each day, Monday through Thursday, back up onto the Day 1-Day 4 set of
backup disks.

3. On Friday, back up onto the Week 2 set of disks.

4. Each day, Monday through Thursday, back up onto the Day 1-Day 4 set of
backup disks.

5. On Friday, back up onto the Week 3 set of disks.

6. Each day, Monday through Thursday, back up onto the Day 1-Day 4 set of
backup disks.

7. On Friday, back up onto the Month 1 set of disks before running end-of-
month routines.

8. Repeat steps 1–7 two times, substituting the Month 2 and Month 3 sets of
backup disks for the Month 1 set of disks. Replace the daily disks after the
third monthly backup.
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Backing Up Company Data
Each DacEasy module includes a Backup function; however, if you have multiple DacEasy
modules in a single company profile you can save time by backing up from the Business
Center. If you have multiple DacEasy modules, it is important that you back up all data files
at the same time.  Select the Profile option to include user defined Crystal Reports, alert
rules and associated files, and profile information such as your passport and tickets in the
backup.

Note  You can schedule to create backups using the Scheduled Tasks feature. For more
information, refer to the section titled “Scheduling Tasks” later in this chapter.

To Back Up Company Data
1. Select Back Up Company Data from the Tools menu. The Backup

Wizard appears.

Figure 5-6: Use the Backup wizard in the Business Center to back up your
company data files and profile information. This keeps all your data synchronized.

2. Select the profile and modules you want to back up, and then click Next.
The default location where each backup is stored appears.

Tip  Back up all modules in a company profile at the same time. This
ensures that your data files stay synchronized.

3. Edit the location if necessary, and then click Next. A Confirmation screen
appears.

4. Click Finish to make the backups.
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Restoring Company Data
Each DacEasy module includes a Restore function; however, if you have multiple DacEasy
modules in a single company profile you can save time by restoring from the Business
Center. If you have multiple DacEasy modules, it is important that you restore all modules at
the same time to keep your data synchronized. Be sure the backups you are restoring into
each module were all created at the same time.

To Restore Company Data
1. Select Restore Company Data from the Tools menu. The Restore

Wizard appears.

Figure 5-7: Use the Restore wizard in the Business Center to restore backups for
each module and the profile information.

2. Select the profile and modules you want to restore, and then click Next.
The default backup location appears.

Tip  Be sure the backups you are restoring into each module were created
at the same time. This ensures that all your data files stay synchronized.

3. Edit the location if necessary, and then click Next. A Confirmation screen
appears.

4. Select the Enable Rollback check box protect your data integrity. This
option allows you to return your data to its previous state should you
experience a failure during the Restore routine. Click Finish to restore the
backups.
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Changing the Date
DacEasy defaults to the computer’s current system date; however, you can change the
default date in DacEasy if you need to enter activity for a different date. Changes made to
the DacEasy date do not affect the computer’s system date.

Note  You can also change the date from any DacEasy module. To change the date within a
DacEasy module, click Options, and then select Date (or press F4). If you are running the
DacEasy module independent of the Business Center, the new date is used for all activity
until you close the program. If you change the date from a module accessed through the
Business Center, the change only applies to the current screen until that screen is closed.
When you access the screen again, the date defaults to the Business Center date.

To Change the Program Date
1. Select Program Date from the Tools menu. The Enter Program Date

dialog box appears.

2. Select the date.

3. Click OK.
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Modifying the Business Center Appearance
You can modify the appearance of the Business Center by selecting a scheme and
customizing module toolbars. You can select a scheme to modify the appearance of the
Business Center to meet your needs. You can also create as many customizable module
toolbars necessary to fit your business needs.

Selecting a Scheme
Each scheme includes the layouts for the standard Modules toolbar, Modules menu bar,
Activities pages and Workflow Guides. The DacEasy Classic scheme, includes tasks from
all DacEasy modules. You can also select schemes for a specific DacEasy module.

To Select a Scheme
1. Select Appearance from the Tools menu. The Appearance dialog box

appears with the Scheme tab open.

Figure 5-8: Use the Scheme tab on the Appearance dialog box to change the
appearance of the standard Modules toolbar, Modules menu bar, Activities pages
and Workflow Guides.

2. Select a scheme or click Use Default to use the default scheme, which is
based on the modules in your profile.

Note  The DacEasy Classic scheme consists of all DacEasy modules.
Select this scheme if you use more than one DacEasy module. If you use a
single DacEasy module, you can select a scheme that contains only
options for the module you use.
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3. Click OK. A prompt confirming the scheme selection appears.

4. Click Yes. The Business Center is updated with your changes and your
default home page appears in the workspace.

Customizing Business Center Module Toolbars
Customizing the Modules toolbars allows you to customize the toolbars in the Business
Center to work the way you do. You can create and customize as many toolbars as necessary
pulling tasks from DacEasy or any application you want to access from the Business Center.
You can create toolbars for daily and periodic processes such as Year End. You can hide the
Year End toolbar for most of the year and only view it when it is needed.

To Add and Edit a Module Toolbar
1. Select Appearance from the Tools menu. The Appearance dialog box

appears with the Scheme tab open.

2. Click the Toolbars tab.

Figure 5-9: Use the Toolbars tab of the Appearance dialog box to add and edit
module toolbars.

3. Select New to create a new toolbar. Type the name of the toolbar if you
are creating a new toolbar when it appears in the Available Toolbars list. If
you are editing an existing toolbar proceed to the next step.

4. Select the toolbars you want to appear using the Available Toolbars list. A
check mark appears next to each toolbar indicating the toolbar appears in
the Business Center.
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5. Select the Show Labels check box if you want the button labels to appear.
There are three options when selecting the Show Labels check box.

Select the Show Labels check box and the button labels appear for all
toolbar buttons.

Clear the Show Labels check box and the button labels do not appear for
toolbar buttons unless no image is selected for the button.

Select the Show Labels check box until it is dimmed and the button labels
only appear when the same image is selected for multiple toolbars buttons,
regardless of the toolbar. For example, if both the Year End and
Accounting toolbar are using the same image for a button, the button label
appears for both buttons.

6. Select the Show ToolTips check box if you want the button ToolTips to
appear.

7. Select the With Hot Keys check box if you want to use hot keys to
activate the associated task for a toolbar button. The hot keys are assigned
using the Properties dialog box.

Tip  When using the With Hot Keys option, try to assign unique hot keys
because hot keys assigned to a toolbar button in the Business Center
override original hot keys while the Business Center is running. For
example, Ctrl + C copies information to the clipboard. If you assign this
hot key to a toolbar button, this hot key launches the task assigned in the
Business Center and no longer copies text to the clipboard while the
Business Center is running. Close the Business Center and the hot key
returns to the original task.
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8. Select the toolbar you want to edit, and then select Customize to add, edit
or delete buttons on the toolbar. The Customize Toobar dialog box
appears.

Note  You cannot customize the standard Module toolbar. The tasks that
appear on the standard Modules toolbar are defined by the scheme
selected for the current user.

Figure 5-10: Use the Customize Toolbar dialog box to add, edit or delete buttons on
the toolbar.

9. Select a task from the Available Toolbar Buttons list and select Add or
double-click the task. Once the task appears in the Current Toolbar
Buttons list, use Move Up or Move Down to change the order the task
appears on the toolbar. Continue this step until all tasks you need are in
the Current Toolbar Buttons list.

Note  You can also add tasks not associated with DacEasy to the toolbar.
For example, you can drag and drop a shortcut from your desktop to the
Current Toolbar Buttons list. You can also use the Properties dialog box
to assign a button to a specific tasks. For example, a Microsoft Word
document you want to view, or executable file you want to run.
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To edit the properties of a task, click Properties or double-click the task in
the Current Toolbar Buttons list. The Properties dialog box appears.

Figure 5-11: Use the Properties dialog box to change the details of each task. You
can change the target, label, hot key and ToolTip for the task.

10. Make any necessary changes to the properties available. Type a Hot Key
to quickly access the task from any application while the Business Center
is running. Select Change Image to change the icon image associated
with the current task. The Change Image dialog box appears.

Figure 5-12: Use the Change Image dialog box to change the icon image
associated with a task. You can navigate to another icon image, or pull images
from other files containing icons.

11. Click OK to save your changes and return to the Properties dialog box.
Click OK again to save the property settings and return to the Customize
Toolbar dialog box. Click OK to save the toolbar settings. Click OK to
save the appearance settings.
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Setting the Business Center Options
Use the Options dialog box in the Business Center to set preferences for various features.
These preferences include selecting the Home page, backup and restore defaults and
AutoComplete settings.

To Change the Home Page
The home page automatically appears in the Business Center workspace each time you start
the Business Center. If you are viewing a different page, you can quickly load the home
page at any time by clicking the Home Page button on the Explorer bar.

1. Select Options on the Tools menu. The Options dialog box appears with
the Workspace tab open.

Figure 5-13: Use the Workspace tab of the Options dialog box to select the Home
page that appears when you first open the Business Center.
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2. Select the address of the home page using any of the following methods:

Use Current—Click this button to use the page that currently appears in
your workspace as the home page.

Use Default—Click this button to use the Business Center's default home
page, which is the Resources page, as your home page.

Use Blank—Click this button to use Internet Explorer's default blank
page. Your workspace will have a white background.

Tip  If you prefer the background to be a solid color other than white,
DacEasy includes additional pages you can use as your default. These
pages are located in the \Bc\Html\Bkgnd subfolder in the Business Center
application folder. For example, if you installed the program into the
default folder, type C:\DacEasy\BC\HTML\Bkgnd\Blueblank.htm to use a
solid blue page in the workspace.

3. Click OK to save your change.
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To Select the Default Backup Location
1. Select Options on the Tools menu. The Options dialog box appears. Click

the Backup tab.

2. Type the default backup location in the Destination area or use the
following buttons to select the path.

Click the arrow button next to the Default Backup Location field to select
a system variable. The variable, which is enclosed in angle brackets, is
inserted where the cursor is located. You can use any combination of
variables and combine variables with text as long as the combination
results in a valid path.

A description of each variable follows:

Profile Folder—The folder where the profile is located. You can view
this path on the Paths tab of the Edit Company Information dialog box.

Module Data Folder—The folder where the data is located for the
current module data being backed up. You can view this path on the Paths
tab of the Edit Company Information dialog box.

Today’s Date—The computer’s current system date using the
YYYYMMDD format.

Day of Week—The current day of the week based on the computer’s
current system date.

Click the Browse button next to the Default Backup Location field to
browse for the folder.

Tip  Click the Use Default button to use to the default path, which is
<PROFILEDIR>\Backups\<TODAY>.

3. Click OK to save your changes.



146            DacEasy Instal lat ion & New Features Guide

Chapter 5   Working With the Business Center

To View the Backup/Restore History
1. Select Options on the Tools menu. The Options dialog box appears. Click

the Backup tab.

2. Click History. The Backup/Restore History dialog box appears.

Note  If you entered a controller password on the Company Profile User
List dialog box, you must enter this password on the Enter Controller
Password dialog box that appears.

Note  If you want to remove entries from the activity log, select the
activity, and then click Remove.

3. Click Close to exit this dialog box.

To Set AutoComplete Preferences
Before you use the AutoComplete feature, you can select certain preferences to fit your
needs. For more information on the AutoComplete feature, refer to Chapter 4, Working With
DacEasy.”

1. Select Options on the Tools menu. The Options dialog box appears.
Click the Edit tab. The Edit tab appears.

2. Select the settings you want to use for the AutoComplete feature. The
settings you select on the Edit tab are specific to the current user logged
on to the Business Center and apply to each DacEasy module you have
installed.

Tip  Click Help from the Options dialog box for a detailed description of
each option.

3. Click Close to exit this dialog box.
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Setting Business Alert Rules
Before you can use the Business Alerts routine in the Instant Advisor, you need to
determine which alerts you need and set the appropriate rules. For example, if you want to be
alerted that an account has exceeded your budgeted amount, you would set up an Alert Rule
for that account. For more information on the Business Alert feature, refer to Chapter 6,
“Working With Business Center Pages.”

To Set Business Alerts
1. Select Business Alert Rules on the Tools menu. The Alert Rules dialog

box appears.

2. Click New to add a new Alert Rule. If you want to edit an existing Alert
Rule, select the rule in the Alert Rule list and click Modify. The Alert
Rule Wizard appears.

Follow the instructions on the screen to set the Alert Rule. Use the Back
and Next buttons to navigate through the wizard. Click Finish when you
have completed the wizard.

Once you have added the Business Alert Rules, view the rules on the
Alert Rules dialog box. The Business Alerts feature does not allow
duplicate Alerts for a single item to appear in the Business Alerts list. Use
the order of the rules in the Alert Rules dialog box to determine which
rule should appear in the list should DacEasy detect a duplicate alert.

3. Click OK to save the changes.

If the Business Alerts page is in current view, a message appears asking if
you would like to regenerate the Business Alerts list to include the recent
changes to the rules.

If the Business Alert page is not in current view, you must view the
Business Alerts page and click the Regenerate Items button. This updates
the Business Alerts list to include the changes to the rules.
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Scheduling Tasks
The DacEasy Business Center provides a Schedule Task wizard that allows Windows to run
a DacEasy task automatically. This wizard is available from the Tools menu on the Business
Center menu bar or from the Instant Advisor page in the Business Center workspace. This
feature allows you to schedule recurring backups and Business Alerts using integration
between DacEasy and the Windows Task Scheduler. With this integration, your Windows
operating system runs and maintains the scheduled task, while DacEasy performs the
scheduled task such as running a backup of your data files or generating a Business Alert.

To Schedule a Task
1. Select Schedule Tasks from the Tools menu. The Schedule Task List

dialog box appears. You can also access the Scheduled Task List dialog
box by selecting Instant Advisor from the Business Center Workspace,
selecting Scheduled Tasks, and then selecting New.

Figure 5-14: Use the Schedule Task List to identify the computer from which you
want to run the scheduled task and select the type of task you want to schedule.
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2. Select the Target Computer and the type of task you want to schedule.
Click OK and the Schedule Task Wizard appears. You have two options
when selecting the target computer. You can schedule a task on the local
machine (this computer) or the server (gateway).

A gateway machine is defined as the “permanent gateway” as identified
by Pervasive, or the computer where the profile data actually resides. The
local machine or “this computer” is defined as the client machine where
DacEasy is being run, if this machine is the same as the gateway, the local
machine is suppressed.

Note   A user must have access rights to the Windows Task Scheduler
routine to schedule a task in DacEasy

Note  We recommend you schedule all tasks on the gateway computer.
Since the gateway computer is the physical computer that serves the data
or contains the data, the gateway computer should always be accessible.

If you are accessing a profile on a network and select your local machine
(this computer) as the target computer, the following warning appears.
“Scheduling a task on the local computer using a network profile is not
recommended. If you select to continue, the scheduled task will not be
available from other workstations or server.”

3. The next pages of the wizard that appear are specific to the type of task
you are scheduling. For more information scheduling a specific task, refer
to the Business Center Help. After selecting the settings specific for the
task you are scheduling, select Next to continue. The Frequency page of
the wizard appears.

Figure 5-15: Select the frequency to determine how often you want the scheduled
task performed.
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4. Select the frequency you want and select Next to continue. The next page
to appear depends on the frequency you selected.

Note  Refer to the Business Center Help for more detailed information on
each frequency option.

5. Select your frequency settings. Select Next to continue. The Windows
Authentication page of the Wizard appears if the target computer requires
user authentication. If the target computer does not require user
authentication, the Summary page appears. Proceed to step 7 if the
Summary page appears.

Figure 5-16: Use the Windows Authentication page to enter your Windows user
name and password.
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6. Type the Windows user name and password for the user you want to
assign to run the scheduled task. The current user name logged in
automatically appears. Change the user name, if necessary. If you choose
to change the user name be sure to enter a valid user name that is
recognized by your operating system and has the appropriate access to run
the scheduled task. This information is not confirmed until the scheduled
tasks is performed. When saving the Scheduled Task, DacEasy fails if it
attempts to write information to the Windows Task Scheduler and the user
name is not valid. Select Next to continue. The Summary page of the
wizard appears.

Figure 5-17: Use the Summary page to name the task you are scheduling and
review the scheduled task settings.

7. Type a name for the task you are scheduling and review the settings.
Select Back to correct a schedule task setting. Select Finish to complete
the Schedule Task Wizard
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Managing Windows
You can only have one Business Center window open at a time; however, you can have
multiple DacEasy module windows open at the same time. To open a DacEasy module
window, select a command from a menu on the Modules menu bar, click a button on the
Modules toolbar or use the Activities or Workflow Guide Business Center pages.

Selecting the Active Window
Use any of the following methods to select the active window.

Windows menu—Each open window appears on the Windows menu. The
windows are listed in order of the most recently opened window. Select a window
to make it active. If the window is open but does not appear on the Windows menu,
select Windows... and a list of all open windows appears. To open a window, select
the window, and then click Activate.

Task bar—Each open window appears on the Windows taskbar. Click the button
on the taskbar to make the window active.

Select the window—If a window is visible on the desktop, you can click anywhere
on the window to make it the active window.

Managing the Workspace
The Business Center workspace uses Internet Explorer. Internet Explorer is a browser that
allows you to view HTML pages. The Business Center workspace is designed to display
HTML pages located on your computer. These pages access the various activities using the
DacEasy modules in the company profile. You can also use the Business Center workspace
to view HTML pages on the Internet.
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Viewing the Workspace
The first time you start the Business Center, the workspace includes a default Business
Center Home page. If you do not want to view the workspace in the Business Center, you
can click the Workspace button on the Business Center title bar or use the Windows menu
to hide the workspace. If the workspace is hidden, click the Workspace button or use the
Windows menu to show the workspace. Refer to the section titled “Business Center Title
Bar” earlier in this chapter for help identifying the Workspace button. Refer to Chapter 6,
“Working With Business Center Pages” for more information on the pages that appear in the
Business Center workspace.

Using the Explorer Bar
The Business Center Explorer bar consists of an Explorer toolbar and an Explorer Address
bar. To load a specific page, type the address in the Address bar, and then press Enter. A
description of each button on the Explorer toolbar follows.

Back—Returns you to the last page you viewed.

Forward—Returns you to the page you viewed before you clicked Back.

Stop—Stops loading the current page.

Refresh—Reloads the current page.

Home Page—Loads the page specified as the default home page.

Tip  You can specify a different home page. For more information on
changing the home page, refer the to the section titled “To Change the
Home Page” earlier in the chapter.

Business Center Home Page—Loads the original default home page.
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W
orkspace Pages

Chapter 6

Working With Business Center
Pages

Chapter 5 gave you a basic understanding of the Business Center. One of the most powerful
components of the Business Center is the ability to view HTML pages in the workspace.

Many powerful features are available from the HTML pages that DacEasy installs on your
hard disk drive. This chapter is dedicated to explaining how to use these pages and the
benefits derived from these pages.

You are likely to use the pages in the Business Center workspace on a daily basis. The
workspace provides access to the Resources page, Activities pages, Instant Advisor,
Instant Reports and Workflow Guides. These pages provide quick access to helpful
information, the Internet and your company data files.
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Accessing Additional Resources
The Resources feature includes a collection of links to helpful pages on the Internet. Using
these links, you can quickly do things like take a tour of the new features, access the
DacEasy Web site, get online support, register your software, find a consultant in your area
and view the readme. To view the Resources page, click Resources on the Navigation bar, or
click the Business Center Home Page button on the Explorer bar.

Figure 6-1: Use the Resources page to access additional resources on the Internet. This includes
viewing the New Features Tour and online support, registering your software, viewing the DacEasy
Web site and ordering products. You can also view helpful tips in the Tip Center on this page.
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Using the Resources Links
The Resources links are found on the Contents bar. Most of these links take you to pages
on the DacEasy Web site. Use these links to register your software, find out the latest
information about the DacEasy products or find a Certified Consultant in your area.

There are also links to the many support options provided by DacEasy’s award-winning
Customer Support Services division. These options include downloading the latest patches
and utilities. Being able to quickly access the support options is especially helpful when you
need an answer to your question right away. You no longer need to view another browser,
remember the Web address, and then type it in. Some of the online support options require a
Support plan. For more information on support options, refer to the section titled
“Additional Resources” in Chapter 2, “User Assistance.”

Use the link to the New Features Tour to familiarize yourself with the many powerful new
features in DacEasy. Each new feature is presented in an easy-to-follow format that includes
a feature overview along with steps and procedures. Once you are familiar with the feature,
you can click the Take Me There button to go directly to that feature.

Use the links to DacEasy’s secured store to order checks and forms guaranteed to be
compatible with DacEasy. You can also use these links to order DacEasy products. You can
install and use any of the DacEasy products available on the CD for a trial period. By
ordering online, you can continue to use the new products without any interruption.

Using the Tip Center
The Resources page also includes a Tip Center. The Tip Center appears in the Contents area
and provides you with useful tips on the many features found in all the DacEasy products.
Some of the tips are daily reminders that appear on certain days throughout the year. Each
time you access the Business Center; a new tip appears in the Tip Center. To view more tips,
click Next. To view the previous tip, click Previous.
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Selecting Activities
The Activities feature includes a collection of pages that organize related features,
regardless of the DacEasy module, into logical groupings. The links on the Activities pages
provide quick access to your data. With the click of a mouse, you quickly access a feature in
DacEasy without using the menu or toolbar. For example, you can access the Inventory
Activities page to enter Promotional Prices in Point of Sale, view the Production Schedule in
Order Entry and use the Price Assignment feature in DacEasy Accounting.

Figure 6-2: Use the links on the Activities pages to quickly launch DacEasy activities.
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You can access the following Activities pages: Customer, Vendor, Banking, Inventory,
General Ledger, Company, Payroll and Your WebStore. When you click Activities on the
Navigation bar, the Customer Activities page appears as the default. You can select a
different Activities page from the Contents bar.

Each Activities page includes areas related to the selected Activity page. When you click an
area, the individual activities associated with that area appear. If you did not install a
particular DacEasy module or include a module in the company profile, the activities for the
module are not available. The activities listed may also include pages available in the
Business Center. For example, if you select the Customers area from the Customer Activities
page, a Setup Guide option is included in the list of activities. If you click this option, the
Setup Workflow Guide appears in the Business Center workspace. For more information on
using workflow guides, refer to the “Using Workflow Guides” section in this chapter.

To Launch an Activity
1. Click Activities on the Navigation bar in the Business Center workspace.

The Customer Activities page appears in the Contents area.

To select a different Activities page, click the appropriate page on the
Contents bar.

2. Click the area that contains the activity you want to access. A list of
activities related to that area appears.

Note  If an activity appears dimmed, the module is either not installed or
not included in the company profile.

3. Click the activity. The appropriate dialog box or page appears.
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Working With the Instant Advisor
The Instant Advisor feature includes three unique features that help you keep up to date
with your company’s data. These features are the Payables Reminder, Business Alerts and
Scheduled Tasks. Use these three routines to find out information about your company's
status quickly.

Figure 6-3: The Instant Advisor quickly shows you the invoices you have due on the Payables
Reminder page, alerts you of specific activity going on in your business, like low inventory levels, on
the Business Alerts page and allows you to view and schedule recurring backups and Business
Alerts on the Scheduled Tasks page.
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Viewing the Business Alerts
Being in touch with your company's status helps you make good business decisions. Set up
the Business Center to alert you when certain conditions are met. For example, you can set
up an alert so you are notified when the inventory level of an item reaches a minimum. Once
you get the alert, you know immediately that you need to order more of that item from your
vendor. In addition to viewing the alert in the Instant Advisor, you can use the Business
Center's Instant Correspondence feature to send an e-mail to you or your staff so they are
aware of the alert.

Before you can use the Business Alerts routine in the Instant Advisor, you need to
determine which alerts you need and set the appropriate rules. For example, if you want to be
alerted that an account has exceeded your budgeted amount, you would set up an Alert Rule
for that account. For more information on setting Business Alert rules, refer to Chapter 5,
“Working With the Business Center.”

Note  You can set Business Alert Rules for general ledger accounts, customers, vendors,
inventory items and employees.

Note  You can schedule to generate a Business Alert as a recurring task using the
Scheduled Tasks feature. For more information on this feature, refer to the section titled
“Scheduling Tasks” in Chapter 5, “Working With the Business Center.”

The Business Alert list includes the following information for each alert, the status, alert
name, the item for which the alert is concerning, the date the alert was last updated and the
date the alert was last detected. To quickly view specific information regarding the alert,
place the mouse cursor over an alert in the Business Alert list and the information appears as
a ToolTip. Select an alert and right-click to view the shortcut menu. Use the shortcut menu
from the Business Alert list to quickly perform other routines such as, changing the status of
an alert, opening or sending e-mails, deleting an alert and viewing an alert’s properties.

When you generate the Business Alert list, the status of the alert is updated automatically if
the following conditions apply:

If the status of an alert is Closed, and the alert is detected again, the status of the
alert is changed to Open.
If the status of an alert is Open, and you send an e-mail from the Business Alerts
page, the status of the alert is changed to Pending.

Each of these actions is recorded in the alert’s history, which can be viewed on the History
tab of the Business Alert’s Properties dialog box.
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To View Business Alerts
1. Click Instant Advisor on the Navigation bar in the Business Center

workspace. The Instant Advisor page appears in the Contents area with
the Business Alerts list in view

Note  Duplicate alerts do not appear in the Business Alert list. If you set
Business Alert rules that are similar and a duplicate alert would be
generated, the alert is only generated once for the rule with the highest
priority. For more information, refer to the section titled, “Setting Business
Alert Rules” in Chapter 5, “Working With the Business Center.”

2. Click Regenerate Items to update the Business Alerts list if necessary.
The Business Alerts are not updated online. To update the Business
Alerts list, you must click the Regenerate Items button.

Tip  To speed generating the Business Alerts list, post all transactions in
all modules before clicking the Regenerate Items button.

3. Select an alert or group of alerts in the list.

Click Rules to view the Alert Rules dialog box. Use this feature to add,
modify and delete Alert Rules.

Click Properties to view detailed information about the alert. This
information includes dates regarding the alert, conditions met, details
about the conditions, and the Alert history. Use the Properties feature to
change the Alert status.

Click E-mail to send the composed e-mail to the specified e-mail addresses
set on the Business Alert rule.

Click Delete to delete the selected alerts.

Note  If you delete an alert and the conditions still apply based on an
Alert Rule, the alert will appear in the list again when you regenerate the
list.

Related Help Topics
Changing the status of an alert
Deleting alerts
Changing the Business Alerts View



W
orkspace
P

ages

Working With Business Center Pages   Chapter 6

Viewing the Payables Reminder
Use the Payables Reminder to keep up with the bills you have to pay. The Payables
Reminder is automatically set up to notify you of all invoices you have coming due. This
feature saves you time and money, by reminding you to pay your bills in a timely manner.
The Payables Reminder shows you all the bills you need to pay within a certain period of
time automatically. You no longer need to print reports to find out when invoices are due,
wasting your time and paper. You can also launch the DacEasy Accounting AutoPay feature
from the Payables Reminder and pay your invoices with a few clicks of a button.

Note  This feature is only available if DacEasy Accounting is in the company profile.

Related Help Topics
Changing the Payables Reminder View

To View the Payables Reminder
1. Click Instant Advisor on the Navigation bar in the Business Center

workspace. The Instant Advisor page appears in the Contents area.

2. Click Payables Reminder in the Contents bar. The Payables Reminder
appears in the Contents area. The due date, vendor's name and a summary
total of the amount you have due to the vendor appears in the Summary
area (or top portion) of the Payables Reminder.

Note  The information that appears in the Payables Reminders is not
updated online. To view updated reminders, you must generate the
Payables Reminder by viewing the Instant Advisor and clicking the
Refresh button on the Explorer bar.

3. Click the vendor's name in the top portion of the Payables Reminder and
the individual invoices that are due for that vendor appear in the Invoices
area (or bottom portion) of the Payable's Reminder.
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4. Click the Pay All option in the Invoice Area (at the bottom of the Payables
Reminder) to use the AutoPay feature in DacEasy Accounting to pay all
invoices that appear in the Payables Reminder. Select an invoice or a
group of invoices in the Payables Reminder and click the arrow next to the
Pay All option to view more AutoPay selections. Select one of the options
that appear. The following selections are available, Pay All, Pay Selected
Group and Pay Selected Invoice.

Note  For more information on using the AutoPay feature, refer to the
Help topic titled "Paying vendors with AutoPay" in the DacEasy
Accounting Help system.

Viewing the Scheduled Tasks
Use Scheduled Tasks to schedule recurring backups and Business Alerts using integration
between DacEasy and the Windows Task Scheduler routine. Now save time and enjoy more
peace of mind using the Scheduled Tasks feature to easily schedule backups at night when
your data files are not in use. You can also generate your Business Alerts unattended and
receive notification of important activities before they become critical.

Note  For steps on scheduling a task, refer to the section titled “Scheduling Tasks” in
Chapter 5, “Working With the Business Center.”

To View the Scheduled Tasks
1. Click Instant Advisor on the Navigation bar in the Business Center

workspace. The Instant Advisor page appears in the Contents area.

2. Click Scheduled Tasks in the Contents bar. The Scheduled Tasks appears
in the Contents area. The task name, task type, schedule, next run time,
last run time, status, creator and computer information appear in the list for
your reference. To quickly view information regarding the scheduled task,
place the mouse cursor over a scheduled task and the information appears
as a ToolTip

3. Select a task in the list, and then click Edit to change the settings of the
scheduled task. Click New run the Schedule Task wizard to create a new
scheduled task. Click Delete to remove a scheduled task.

Note  For more information on the Scheduled Tasks, refer to the Business
Center Help.
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Working With Instant Reports
Instant Reports provide quick access to key reports in the DacEasy modules. An additional
benefit is the ability to drill down on vital information to view the associated detail. For
example, you can view the Trial Balance, and then drill down on an account balance to view
the activity that makes up the balance.

Figure 6-4: Instant Reports allow you to quickly view your data, and then drill down to further detail.
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Changing Instant Report Criteria
Instant Reports use the standard report’s default criteria to reduce the steps required to
produce the report; however, you can change the criteria.
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To Change Instant Report Criteria
1. Click Instant Reports on the Navigation bar in the Business Center

workspace. The Accounting Instant Reports page appears in the Contents
area.

To select a different module, click the appropriate module on the Contents
bar.

2. Click the icon to the left of the report name. A dialog box appears with the
available options for the report.

Note  If the report name appears dimmed, the module is either not
installed or is not included in the company profile.

3. Select the report options.

4. Click OK. The Instant Report appears based on the criteria selected.

Note  The changes to the report criteria are not saved.
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Viewing Instant Reports
Instant Reports are viewed within the Business Center workspace. Although the same
reports are available in the individual DacEasy modules, you must view these reports in the
Business Center if you want the ability to drill down to further detail.

To View Instant Reports
1. Click Instant Reports on the Navigation bar in the Business Center

workspace. The Accounting Instant Reports page appears in the Contents
area.

To select a different module, click the appropriate module on the Contents
bar.

Tip  Point to a report name to view a description of the report with a
sample. You can click the sample report to enlarge the image, and then
click the Back button on the Explorer toolbar after viewing the sample to
return to the Instant Reports page.

2. Click the report name. The report appears in the workspace.

Note  If the report name appears dimmed, the module is either not
installed or is not included in the company profile.
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Drilling Down on Data
Instant Reports allow you to click on certain items on the report to view additional
information. This is referred to as the drill down feature. When you point to information that
has a drill down, the information changes colors, a line appears below the information and
the pointer changes. Click on the information, and another report or a dialog box appears
detailing the information you drilled down on.

Note  You can drill down to the original transaction when viewing the Accounts Receivable
Aging Report or Accounts Payable Aging Report. This powerful feature required a change
in the way DacEasy stores customer and vendor activity; therefore, these drill downs are
only available on information entered into Version 11 or later.

Using the Report Footer Options
The options in the footer of the Instant Report allow you to increase your viewing area,
select a different page and regenerate the report.

Figure 6-5: Use the report footer options to manipulate the instant report.
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Viewing the Report in the Full Workspace
Click the Full Workspace button to view the report in the entire Business Center workspace.
This reduces scrolling if you are unable to view the entire report due to your display
settings.

Selecting the Page to View
Click the First, Previous, Next and Last buttons to quickly view the corresponding pages.
To quickly view a particular page, type the page number in the Current Page box.

Regenerating Instant Reports
Click the Regenerate Report button to refresh the report with the latest data. This is useful if
you stopped the report generation or if you are operating in a multi-user environment and
need to view the latest information.
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Using Workflow Guides
The workflow guides included in the Business Center workspace consist of step-by-step
guides that assist you in successfully completing certain DacEasy processes. These guides
are especially useful when completing involved processes such as setup or processes not
performed as part of your regular routine, such as closing the year.

Workflow guides break down the process into phases. Each phase appears just below the
page title. When you click a phase, a list of each step in the phase appears. You can point to
the step to view a description. If the step applies, click the option to access the appropriate
dialog box.

Figure 6-6: Use the workflow guides to assist you with your workflow processes.
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To Complete a Workflow Process
1. Click Workflow Guides on the Navigation bar in the Business Center

workspace. The Setup Workflow Guide page appears in the Contents
area.

To select a different workflow guide, click the appropriate guide on the
Contents bar.

Note  Workflow guides that apply to all DacEasy modules are listed just
below the Workflow Guides heading on the Contents bar. Workflow
guides specific to each module are listed below the appropriate module
heading.

2. Click the first phase. The steps associated with the phase appear.

Tip  Point to a step to view a detailed description. Because not all steps
are required, you can also confirm that this step applies to your business.

3. Click the step you want to complete. The appropriate dialog box appears.

Note  If a plus appears on the bullet, the step applies to multiple DacEasy
modules. Click the step to view a list of applicable modules. Click a module
and the appropriate dialog box appears. After completing the step for each
module, you can click the step to hide the list of modules.

4. Complete the dialog box, and then click OK to save your changes.

5. Click the next phase, and then complete each step. Continue this step for
all phases.



Appendix A

Networking

This chapter provides general information about using DacEasy on a network. Before you
begin, make sure you have already purchased and successfully installed a Local Area
Network (LAN). Refer to your Network Operating System manual or your network
administrator if you have questions on installation, operation or usage of your LAN
hardware or its operating system.

Before Installing DacEasy
This section describes some options you can select during installation. This information is
especially useful if running DacEasy on a network. For more information on installing
DacEasy, refer to Chapter 1, “Installing DacEasy.”

Pervasive.SQL 9.1 Options
DacEasy uses Pervasive.SQL 9.1 as its record manager. During the installation routine, there
are two options available for Pervasive.SQL  9.1. These options are Gateway and
Workstation. Both install the same program files; however, the Pervasive engine is registered
differently with each option. To properly register the Pervasive engine, you must install the
program on the local machine of each workstation on the network. Installing the program to
a remote computer results in improper installation. The differences between the Gateway and
Workstation options follow.

N
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Gateway
If the Gateway option is selected, Pervasive is preloaded into memory when the Installation
is complete and each time the machine is logged on. DacEasy takes less time to start and file
access is more consistent when the Gateway option is selected; however, conflicts may
occur when running other applications that require a different version of Pervasive or
Btrieve. Always select the Gateway option when installing DacEasy on the computer that
contains the DacEasy data files. This option may also be selected if Pervasive or Btrieve
version conflicts are not a factor.

Workstation
If the Workstation option is selected, Pervasive is loaded when you start DacEasy and
unloaded when you stop DacEasy. The advantage of the Workstation option is fewer
conflicts with other programs that use different versions of Pervasive or Btrieve; however,
DacEasy may take longer to start and you may experience inconsistent runtime access to
DacEasy data files.
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General Networking Information
Network systems handle files differently than single user systems. The following sections
explain some useful information on how the network version of DacEasy operates.

Network Degradation
Some routines in DacEasy are hard disk intensive. This means they read and write to the
hard disk continuously. These include the Year End routines, data entry, File Utility routines
and Posting routines. If you are using DacEasy in a multiple user environment or if there are
stations running other software programs, you may want to run these hard disk intensive
routines during a slower period of the day. You are able to use other programs or work in
another company while running these processes on another station, but due to their nature,
the system may slow down drastically, depending upon the quality of your network
hardware and software.

Concurrency Control Methods
In your everyday operation of the network version of DacEasy, you share data files with
others. At the precise time you attempt to update a record, another user may request and
update the same record. The practice of two or more users reading from and writing to the
same data files is called concurrency.

Network software automatically manages all concurrency issues for you. This concurrency
control is handled internally, behind the scenes. The software may employ many different
concurrency control methods.

Passive Concurrency
The most common concurrency control convention used by DacEasy is passive concurrency.
With this type of concurrency, any station may read and update data.

For example, a majority of the commands available on the Edit menu exercise passive
concurrency control. If two stations read, and then try to update the same record, the last
station to attempt the update receives an error stating that another user has already updated
the record. After clearing the error message, the changes made by the first user appear on
the second user’s screen.
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File Locking
File locking reserves an entire file for one user and the user has exclusive use of the file.
Certain routines in DacEasy, such as posting, request exclusive use of the files affected. If a
routine uses file locking, it locks all of the necessary files before beginning the task. During
this time, other stations cannot access routines that may use one of the locked files.

For example, when posting billing transactions, no user is allowed to access the Edit
Product dialog box. Likewise, you are not able to post the billing transactions if another
user has the Edit Product dialog box open. The same applies if someone has the Edit
Employee Accumulations dialog box open, you cannot post your payroll transactions until
the user exits the dialog box.

If a certain file is locked and you are accessing an operation that attempts to open the locked
file, it returns an error that a file is currently locked by another station.

Record Locking
Record locking reserves one record within the data file for one user. The user has exclusive
use of that record until the record is released. Most transaction entry routines in DacEasy
utilize record locking.

For example, if a user recalls a record, like a customer, for editing purposes, and a second
user accesses the same record, the second user receives a record lock error. However, since
this is not a file locking situation, the second user may enter or edit another customer.

Mapping the Subdirectories
It is very important that you map a drive that is common to all stations using DacEasy.
Mapping is the network process that allows you to access the server’s drives as you would
your own computer’s. However, since your computer already has a C: drive, you must
assign different letters or map the server’s drives to avoid conflict. If you are unfamiliar with
mapping techniques, consult your network operating system manual or your network
administrator.

For server-to-peer networks, if the server path to DacEasy is
C:\[DacEasy data files folder] and the workstations have that path mapped as F:, then
users access the data files on the F drive, for example, F:\.

You must have a separate data file folder for each modules data files. For example, if you
are using Accounting, Payroll and Order Entry and are operating two companies, you will
have a total of six separate data file folders.
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It is recommended that you install the program on the local drives of each workstation. This
may help avoid mapping problems as well as increase the speed of the program. This is only
possible for workstations with a local hard disk drive.

If you want to use a cache program, consult your network administrator for the best cache
for your system.

Rights and Privileges
During the everyday operation of DacEasy, the program creates and deletes various files.
The creation and deletion of these files is invisible to the user, however, DacEasy requires
this for successful operation of the program. Because of this, you should assign Read, Write
and Create privileges to each folder used by DacEasy. If your network operating system
accommodates them, also assign the folders Delete privileges. The applicable folders
include the program folders, the program database folders, the data dictionary folder and
each data file (company) folder. If you are unfamiliar with privilege assignments, consult
your network operating system manual or your network administrator.

Updating the Company Path
If you are running DacEasy in a network environment, you need make sure the paths to the
data files reflect the network drive. If you are upgrading from a single user version to the
network version, be sure to update the company path to reflect the network drive. This
allows each workstation to access the data files.

Note  If you are running the Business Center in a network environment, use the UNC
(Universal Naming Convention) path when setting up the path to the data files in the
company profile on the server and workstations.

When Using the Business Center
If you are upgrading from a single user version of DacEasy to the network version and you
are using the Business Center, you need to add a new company profile on each computer on
the network running the Business Center. The company profile you are adding on each
workstation and the server uses the UNC path to the data files on the server.

Note  If you moved your data files when upgrading from a single user version to a network
version, you need to add a new company profile on the original computer to reflect the new
network paths to the data files. When adding the new company profile, be sure to also set up
the user names again.
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To Add the New Company Profile
1. Start the Business Center and select New from the Profile menu. The New

Company Profile dialog box appears.

Note  If the Business Center is unable to locate an existing company
profile, the Welcome to DacEasy dialog box appears. Select the Create
New Profile option, and the New Company Profile dialog box appears.

2. Type a unique name to identify the company profile. This name is used to
identify the company when opening your company profile and appears on
the Business Center status bar.

3. Type the path where the new company profile is to be located. This folder
stores information specific to the company profile; therefore, each profile
must be located in a different folder.

4. Complete all applicable fields in the Company Information area.

5. Click Save. The Create New Profile User appears.

6. Confirm your password, and then click OK. The Add Module Wizard
appears.

7. Follow the instructions on the screen to point to the data files on the
server. Use the Back and Next buttons to navigate through the wizard.
Click Finish when you have completed all pages.

Tip  To browse for the existing data files folder on the server, click
Browse, and then select Windows folders.

A Summary screen lists each module that will be added to the company
profile.

A Complete screen appears when the selected modules have been added
to the profile.

8. Click OK. DacEasy opens the profile and returns you to the Business
Center main menu.

Note  If you are adding the new company profile on the original
computer where the data files were located before they were moved to the
network server, be sure to remove the old company profile pointing to the
data files on the local disk drive.
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When Not Using the Business Center
If you are upgrading from a single user version of DacEasy to the network version and you
are not using the Business Center, follow these steps. You need to update the data files path
on the Open Company dialog box to reflect the network drive. This allows each
workstation to access the data files.

To Update the Company Path
1. Select Open on the File menu. The Open Company dialog box appears.

2. Click Add. The Add Company dialog box appears. Complete the
Identification Name field with a short description of your company and
type the path to the data files on the server in the Path field. Click OK and
a message appears stating that files already exist. Choose Yes to continue.

3. Select the company using the path to the data files on the server and click
Default. This switches the new path to the default.

4. Select the company using the path to the local drive and click Delete to
delete the path. This process removes the reference to the local drive from
the Open Company dialog box; however, your data files are not affected.
You will now use the new default company when you open your
company’s data files.
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